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FINALTERM EXAMINATION
Spring 2009
CS101- Introduction to Computing (Session - 2)

Note:- MCQs in Blue are the sure answers and Yellow highlighted are
Quarantined

ExamDate:7/2/2009 12:00:00 AM
Time 120

Marks: 75

Question No: 1 (Marks: 1) -Please choose one

breaks down the message to be sent over the internet into
packets.

» FTP
» HTTP
» TCP (page.no.317)
> IP
Question No: 2 (Marks: 1) -Please choose one

A protocol used for receiving email messages is called

» URL
» Telnet
» POP3 (page.no.213)

» SMTP
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Question No: 3 (Marks: 1) -Please choose one

Aliasing problem can be managed by the size of pixels.

» Reducing (page.no.236)
» Increasing
» Gaining

» Modifying

Question No: 4 (Marks: 1) -Please choose one

Variables allow us to manipulate data through the

» Actual Value
» Reference (page.no.143)
» Length

» Name

Question No: 5 (Marks: 1) -Please choose one

The reserved word allows a determined action to be taken if
the first condition is false.

» For
» While
» Else

» Switch
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Question No: 6 (Marks: 1) -Please choose one

ERP is a type of

» Entertainment software

» Productivity software

» Business software

» Scientific software

Question No: 7 (Marks: 1) -Please choose one
What is/are the use/uses of Word processor?

» To write a letter

» To write Research paper or report

> To create address labels

» All of the given

Question No: 8 (Marks: 1) -Please choose one

Command that allows you to recover form mistakes is called

» Clear
» Edit
» Undo

» Break
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Question No: 9 (Marks: 1) -Please choose one

Automatic machines performing various tasks that were previously done
by humans, are called

» Robotics (page.no.244)
» Computers
» Decision Making Systems

» Autonomous Web Agents

Question No: 10 ( Marks: 1) -Please choose one

The is connected to all other modules of the microprocessor.

» Control unit
» Memory unit
» Floating Point unit

» Arithmetic and Logic unit

Question No: 11 (Marks: 1) - Please choose one

Database consisting of two or more related tables, is called

» Flat file database
» Object oriented database
» Tabular storage database

» Relational database (page.no.263)
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Question No: 12 ( Marks: 1) -Please choose one

can be used for entering, editing, or viewing data, one record at
a time.

» Queries
» Forms (page.no.263)
» Reports

» None of the given options

Question No: 13 (Marks: 1) -Please choose one

Distance learning has got a boost due to the

» Easy communication
» Online interactive contents
» Flexibility

» All of the given options

Question No: 14 ( Marks: 1) -Please choose one

DBMS supports data in terabytes.

» Personal
» Desktop
» Enterprise

» Single-user

http://vustudents.ning.com 5




Question No: 15 (Marks: 1) -Please choose one

After the DoS attack in year 2000, Yahoo servers were recovered in

» 1 hour
» 2 hours
» 3 hours

» 4 hours

Question No: 16 ( Marks: 1) -Please choose one
When web server is busy it gives the following message to the user :
» Time out
» Waiting

» Server busy

» None of the given options

Question No: 17 (Marks: 1) -Please choose one
To stop industrial espionage, we use

» Private network

» Encryption

» Network sniffer

» All of the given options (page.no.277)
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Question No: 18 ( Marks: 1) -Please choose one

based communication allows business entities to
coordinate the activities of their globally spread units with greater
accuracy.

» Intranet
» Internet
» Home

> LAN

Question No: 19 (Marks: 1) -Please choose one

onAbort , onError are the of the image object.

» Event Handler (page.no.286)
» Properties
» Methods

» None of the given options

Question No: 20 (Marks: 1) -Please choose one

Processed data is called

» Information
» Data
» Entity

» Attribute
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Question No: 21 (Marks: 1) -Please choose one

is a client program that uses HTTP to make requests to Web
servers throughout the internet on behalf of the user.

» Web Application
» Web Browser (page.no.18)
» Internet Application

» HTML

Question No: 22 (Marks: 1) -Please choose one
consists of cells arranged in rows & columns
» Spreadsheets Software
» Word processor
» Presentation Software

» Microsoft Paint Software

Question No: 23 (Marks: 1) -Please choose one
Flow control constructs in JavaScript includes:

> If-Else

» Loops and If -Else

» Switch and If-Else

» All of the given choices

http://vustudents.ning.com




Question No: 24 (Marks: 1) -Please choose one
Which is NOT true for JavaScript variable name ?
» Student
» Roll_no_1111
» For

» _schedule

Question No: 25 (Marks: 1) -Please choose one
In JavaScript, second element of an array has the index:
> 2
>0
»1
> 3
JavaScript Array Basics
5 May 2008 ... In this tutorial you learn what a JavaScript array is, ... The

first element hasan index of 0, the second element has an index of 1, ...
www.elated.com/articles/javascript-array-basics/ - Cached - Similar -

Question No: 26 (Marks: 1) -Please choose one

Which protocol is used to control other computer from our own computer
?

» FTP
» NNTP
» TELNET (page.no.211)

» None of the given choices
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Question No: 27 (Marks: 1) -Please choose one
occurs when a function calls itself.
» Recursion
» Call by value
» Call by reference
» Parsing

Recursion - Wikipedia, the free encyclopedia

The function calls itself recursively on a smaller version of the input (n - 1)
and multiplies the result of the recursive call by n, until reaching the ...
en.wikipedia.org/wiki/Recursion - Cached - Similar -

Question No: 28 (Marks: 1) -Please choose one

Which function returns a randomly selected floating point number between
0Oand1?

» floor(x)
» ceil(x)
» random()

» round(x)

Question No: 29 (Marks: 1) -Please choose one

Using Java Script you can write a character at random location on screen
» By applying randomCh() method
» With the help of String object
» With the help of random character property

» There is no built in approach in Java Script
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Question No: 30 (Marks: 1) -Please choose one

The most used form tag is the <input> tag.

» True

» False

Question No: 31 ( Marks: 1)

What are the elements of website design? Any one

Question No: 32 ( Marks: 1)

What kind of information can be stored in a database ?

Question No: 33 ( Marks: 2)

What is meant by universal access of internet services ?

Question No: 34 ( Marks: 2)

What is the database?

Question No: 35 ( Marks: 3)

The event handler attribute consists of three parts. Write about each of
them.

Question No: 36 ( Marks: 3)

What is difference between Design and System Architecture?
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Question No: 37 ( Marks: 3)

What are Trojan Horses ?

Question No: 38 (Marks: 5)

Differentiate between For and While loop by writing the syntax of both
loops.

Question No: 39 (Marks: 5)

Suppose we have a big project. Draw hierarchy of the people involved in
the project?

Question No: 40 ( Marks: 10)

Write down output for the following JavaScript code.

a) <script type="text/javascript">
document.write(Math.sqrt(25)); I/l output ?

</script>

b) <script type="text/javascript">
document.write(Math.pow(5, 3)); Il output ?

</script>

c) <script type="text/javascript">
document.write(Math.min(5, 3)); Il output ?

</script>
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d) <script type="text/javascript">
document.write(Math.max(5, 3)); Il output ?
</script>

e) <script type="text/javascript">
document.write(Math.floor(9.87)); Il output ?
</script>

Question No: 41 ( Marks: 10)

Is tabular data storage better than flat file data storage? Justify your
answer.
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FINALTERM EXAMINATION
Spring 2009
CS101- Introduction to Computing (Session - 4)
Note:- MCQs in Blue are sure answers and yellow highlighted are
Quarantined
Time: 120 min

Marks: 75

Question No: 1 (Marks: 1) -Please choose one

Which of the following hardware component of a computer can also be
called as engine?

» Bus
» Storage
» Memory

» Processor

Question No: 2 (Marks: 1) -Please choose one

TCP stands for

» Total communication protocol
» Transmission control protocol (page. no.317)
» Transfer control protocol

» Transfer collection protocol
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Question No: 3 (Marks: 1) -Please choose one

breaks down the message to be sent over the internet into

packets.
» FTP
» HTTP
» TCP (Page.no.317)

> IP

Question No: 4 (Marks: 1) -Please choose one
A variable can be in scope.

» Local

» Global

» Either local or global (page.no.204)

» None of the given options

Question No: 5 (Marks: 1) -Please choose one

A protocol used for receiving email messages is called
» URL
» Telnet
» POP3

» SMTP (page.no.213)
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Question No: 6 (Marks: 1) -Please choose one

A function is also called
» Sub-program
» Procedure
» Sub-routine

» All of the given option

Question No: 7 (Marks: 1) -Please choose one

Capturing events and responding to them is called
» Function Handling
» Event Handling (page.no.228)
» Event Procedure

» All of the given option

Question No: 8 (Marks: 1) -Please choose one
Which one of the following is NOT a primary color?
» Red
» Green
> Yellow

» Blue
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Question No: 9 (Marks: 1) -Please choose one
are those programs in which the flow of the program is
determined by the user's actions (mouse clicks, key presses) or messages
from other programs.
» Event called programs
» Event processed programs

» Event driven programs

» Event declared programs

Question No: 10 ( Marks: 1) -Please choose one
a = Math.ceil(12.01)
What will be the value of a ?

> 12

> 13

> 12.0

> 13.01

Question No: 11 (Marks: 1) -Please choose one

Event handlers are placed in the portion of a Web page as
attributes in HTML tags.

» HEAD
» BODY (page.no229)
» SCRIPT

» TITLE
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Question No: 12 (Marks: 1) -Please choose one

can be used for entering, editing, or viewing data, one record at
a time.

» Queries
» Forms (page.no.263)
» Reports

» None of the given options

Question No: 13 (Marks: 1) -Please choose one

random() function returns a randomly-selected, floating-point number
between

» 0 and 1
» 0and 10
» 0 and -10

» 0 and -1

Question No: 14 (Marks: 1) -Please choose one

The organizations are learning that business can be done in a more
effective manner if emphasis is placed upon

» Cooperation
» Shared responsibility
» Networking

» All of the given options (page.no.281)
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Question No: 15 (Marks: 1) -Please choose one

In relational database, data store in the form of

» Tables (page.no.321)
» Rows
» Columns

» None of the given options

Question No: 16 ( Marks: 1) -Please choose one

Spies of one business monitoring the network traffic of their competitors’

» Industrial Intelligence
» Industrial Espionage (page.no.277)
» Industrial Spying

» Industrial Surveillance

Question No: 17 (Marks: 1) -Please choose one

waits for some time and then launch a function.

» Timeout()

» setTimeout()
(page.no.290)

» setTime()

» setTimein()
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Question No: 18 ( Marks: 1) -Please choose one

based communication allows business entities to
coordinate the activities of their globally spread units with greater
accuracy.

» Intranet
» Internet (page.no.294)
» Home

> LAN

Question No: 19 (Marks: 1) -Please choose one

The key responsibilities of a project manager is

» Planning and tracking of the project
» Arranging of the appropriate resources
» Client relationship management

» All of the given options (page.no.296)

Question No: 20 (Marks: 1) -Please choose one

team consists on the sharpest technical minds in the

company.
» Architecture (page.no.302)
» Business Development
» Configuration Management

» Developer
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Question No: 21 (Marks: 1) -Please choose one

Smart editors can automatically color different parts of statements in
different colors e.g. comments in color.

» Green
» Grey (page.no.315)
» Blue

» Red

Question No: 22 (Marks: 1) -Please choose one

A collection of data organized in such a way that the computer can quickly
search for a desired data item is known as :

» Retrieving
» Database (page.no.321)
» Information

» DBMS

Question No: 23 (Marks: 1) -Please choose one
Deep Blue was the name of

» computer (page.no.9)

» human

> city

» game
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Question No: 24 (Marks: 1) -Please choose one
Information available on the web is

» mostly free of cost

» costly

» very cheap

» of no use

Question No: 25 (Marks: 1) -Please choose one

Which one is correct?

» <BODY></BODY>
» <body></body>

» Both <BODY></BODY> and <body></body> ( Ref: As HTML is not
case sensitive)

> <BODY/>

Question No: 26 (Marks: 1) -Please choose one
is the best known builder for supercomputers.
» Sun
» Cray Research (page.no.21)
» Microsoft

» Apple
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Question No: 27 (Marks: 1) -Please choose one
Which one is the example of spreadsheet software ?
» MS Word
» MS PowerPoint
» MS Excel

» MS Access

Question No: 28 (Marks: 1) -Please choose one
Currently the BlueRay DVD can store more than

» 10 GB

» 100 GB

» 50 GB (page.no.305)

» 150 GB

Question No: 29 (Marks: 1) -Please choose one
Blue Pacificisanameof __ computer.

» Mini

» Desktop

» Micro

» Super (page.no.21)
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Question No: 30 (Marks: 1) -Please choose one

are powerful pieces of hardware, but not much useful

on their own.
» Microcontrollers
» Microprocessors (page.no.33)
» Integrated circuits

» Ports

Question No: 31 ( Marks: 1)
In programming, what is a loop?
In computer science a for loop is a programming language statement which

allows code to be repeatedly executed. A for loop is classified as an
iteration statement.

Question No: 32 ( Marks: 1)
What are the other names of function? Any one.

Routine , procedure , sub prograam

Question No: 33 ( Marks: 2)
How JavaScript Arrays are heterogeneous ?

Arrays are heterogeneous in java script because at the same time
stimultanously they can hold elements of multiple data types

Question No: 34 ( Marks: 2)

What is the database?
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Data base is a collection of organized data in a proper way that computer
can quickly search for any desired data item , its an easy way of allowing of
manipulation of data,they are design in such a way that access to any
desired data can be identified and reached quickly and easy , they are
generally consist of collection of interrelated files

Question No: 35 ( Marks: 3)
Differentiate between LAN and WAN with one example of each.
Lan is a local area network where as wan is a wide area network

Lan can be used in a specific areas with limited computers where as wan
can be used on computers shared by large distances

For example lan can be used on pc s or an organization located in one

building but wan can be used on large scales like banks all over or in any
Large communication systems

Question No: 36 ( Marks: 3)
What are Trojan Horses ?
Trojen horses are a kind of cyber crime , they are v harmful to computer

because they are stand alone programme and the look like what they are
not like any thing amusing or not harmless like games..

Question No: 37 ( Marks: 3)
Elaborate Rester Graphics with examples.
A raster graphics image, digital image, or bitmap, is a data file or structure

representing a generally rectangular grid of pixels, or points of color, on a
computer monitor, paper, or other display device.

To illustrate the matter further - here's the letter "J":

J
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Look closely at it... Take a magnifying glass to it if you like. You see a "J",
the computer sees something more like this, where ".' represents a zero and
'X' represents a one:

X..X
X..X

XXX.

Where you see a zero, the computer instructs its video hardware to paint
the current background color. A one calls for the current foreground color.
Yes, it is actually a bit more complicated, but it all basically boils down to
one bit or the other making a distinction

between the colors of adjacent pixels, which together form an image.

Question No: 38 ( Marks: 5)

What are the important properties, methods and event handlers of image
object?

The primary use of the image object is to download an image into the

cache before it is needed to display , image object can be used to create
different kinds of animations or to display one of several images based on
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the desired requirement , in java script image object can be used to display
the required pre loaded image

Properties of image object is : height , width ,hspace ,vspace, src , name
border etc

Methods :none

Event handlers:on aboart , onload, onerror etc

Question No: 39 (Marks: 5)
Write the JavaScript code for the Function SumOddNumbers(maxNumber)

that can add non-negative odd numbers up to maxNumber and return their
sum.

Function sum odd numbers(maxnumber){var sum=0;
For(i=0; <maxNumbers;l|++)

{

{

if(i/2==1]]i==1)

sum +=i;

}

return sum;

}

Question No: 40 ( Marks: 10)
Write a note on :
Coding guidelines
Guidelines for developing short programs.

Coding quidelines
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* Always use semicolons to end statements
* Indent blocks of code (2 to 5 spaces)

* Identifiers

* Use the camel back scheme

* Variables: nouns

* Functions: verbs

e Comment Liberally

* Make them descriptive but concise

Gudelines for developing short programs.

* Read and understand the problem
* Do you have all the required data?
* No: Get it

* Else assume it. State it explicitly

* Do the design

Question No: 41 ( Marks: 10)

write a note on each of the following:

a. Vector or Object-Oriented Graphics:

b. Bit-Mapped or Raster Graphics:

A:In Vector or object oriented graphic everything drawn is treated as
object. objects retain their identity after they are drawon. these objects can
later be moved, stretched, duplicated, deleted,etc. they are resolution

independent and have relatively small file size. the examples are: swf, svg,
wmf, ps

http://vustudents.ning.com 28




brass_ibrahim: Vector graphics is the use of geometrical primitives such
as points, lines, curves, and shapes or polygon(s), which are all based on
mathematical equations, to represent images in computer graphics.

brass_ibrahim: The term "vector graphics" is mainly used today in the
context of two-dimensional computer graphics Virtually all modern 3D
rendering is done using extensions of 2D vector graphics techniques
.Virtually all modern 3D rendering is done using extensions of 2D vector
graphics techniques

B:Bit-Mapped or Raster Graphics:

Treats everything that is drawn as a bit-map

If an object is drawn on top of another, it is difficult to move just one of
them while

leaving the other untouched

Changing the resolution often requires considerable touch-up work
Relatively large file size

Examples: gif, jpg, bmp

masood.tariq: Bit-Mapped or Raster Graphics:

Treats everything that is drawn as a bit-map

If an object is drawn on top of another, it is difficult to move just one of
them while

leaving the other untouched
Changing the resolution often requires considerable touch-up work
Relatively large file size

Examples: gif, jpg, bmp
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FINAL TERM EXAMINATION
SPRING 2007
CS101 - INTRODUCTION TO COMPUTING (Session — 3)

Marks: 60
(Time: 150min)

Question No: 1 (Marks: 1) - Please choose one

In Spreadsheets, you can create a relationship between two cells by
using

» Numbers
» Text
» Formulas

» None of given option

Question No: 2  (Marks: 1) - Please choose one

An algorithm that always takes the best immediate or local solution
while finding an answer is

called )

» Deterministic Algorithm
» Non deterministic Algorithm

» Greedy Algorithm

» Randomized Algorithm
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Question No: 3  (Marks: 1) - Please choose one

Which of the following command allows you to recover form mistakes

in MS Word?

» Clear

» Edit

» Undo

» Break
Question No: 4  (Marks: 1) - Please choose one
A operating system allows many

users to take advantage of the computer's
resources, simultaneously

» Single user
» Multi- user
» Single tasking

» Multi tasking
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Question No: 5 (Marks: 1) - Please choose one

Network Interface Card is an device

» Input
» Output
» Input/Output

» Storage

Question No: 6 (Marks: 1) - Please choose one

The decimal equivalent of binary 1000 is

> 7

QuestionNo: 7 (Marks: 1) - Please choose one

Which of the following is NOT RDBMS software?
» My Sql
» MS Excel
» Oracle

» SQL Server
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Question No: 8 (Marks: 1) - Please choose one

A computer virus is a
» Software that saves the computer from being damaged.

» Application software that helps to make different type of
viruses and worms

» Program that spreads itself and destroys other program

» Program that corrects the problems in your computer

Question No: 9  (Marks: 1)

What will be the result of a?
a = Math.abs(-23)

> 23
» -23
» 23.0

> 2.3
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Question No: 10  (Marks: 1)

- Please choose one

A Special program required to view swf (Shockwave Flash) files in web
Browser is called

» TFlash
» Vflash
» plug-in

» None of the given options

Question No: 11 ( Marks: 8)
Match the relevant options from the given two columns and write the
correct options in Column 3.

Column 1 Column

2 Column 3
1.F Mainframe A. Network Traffic

Computers controller
2.H Mosaic B. Laptop
3.E Operating System C. Micro Processor
4A Router D. Software Piracy
5. G Spread Sheet E. Windows XP
6.B Mobile Computer F. Enterprise Servers
7.C Intel 4004 G. VisiCalc
8.D Cyber Crime H. Web Browser
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Question No: 12 (Marks: 12)

(a) What is the difference between Wisdom and Heuristic?

(b) Differentiate between Cyber crime and Cyber warfare.

(c) What is a Relational Database? Give the names of any three
RDBMS softwares?

Question No: 13  ( Marks: 8)

What do you know about the following ? Describe briefly.

a) Enterprise Resource Planning (ERP) Software

b) Spread Sheet
c) Network Topology

d) SMTP

Question No: 14  ( Marks: 10)

(a) What is the difference between High level and Low level programming
languages?
(Marks: 4)

(b)What are the following abbreviations stands for
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(Marks: 3)

1- VolP voice over

IP
2- DNS Domain Name System
3- DOS disk operating system

(c) Name three operations that you can perform on a database
(Marks: 3)

Question No: 15 (Marks: 12)

a) Develop a Web page that prompts the user to enter a
name and then print that name five times by using loop.
A sample is shown in the figures below.

b) Write down the JavaScript function that is equivalent to the following HTML
code?
(Marks: 3)

HTML code JavaScript function
<FONT size=18> fontsize(18)

</FONT>

<FONT color="blue”> fontcolor(blue)

</FONT>
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<PRE> ... </PRE> fixed()

(c) Suggest any three guidelines to make a website more readable?
(Marks: 3)

http://vustudents.ning.com
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FINALTERM EXAMINATION
Fall 2008
CS101- Introduction to Computing (Session - 2)

Note:- Yellow highlighted is Quarantine option and Blue is Clear

Question No: 1 (Marks: 1) - Please choose one

Which function returns a randomly selected floating point number between 0 and 1 ?
» floor(x)
» ceil(x)
» random()(Correct)

» round(x)

Question No: 2 (Marks: 1) - Please choose one
Functions are also called:

» Heuristics

» Variables

» Arrays

» Subprograms (Correct)

Question No: 3 (Marks: 1) - Please choose one

In JavaScript, each element of array can store data of type
» A Number
» An Array
» A String variable

» All of the given choices (Correct)
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Question No: 4 ( Marks: 1)

- Please choose one

The weaknesses of the computer are:

» Pattern recognition & Storage

» Speed & Innovative ideas

» Pattern recognition & Innovative ideas (Correct)

» Speed & Storage

Question No: 5 ( Marks: 1)

Processed data is called

» Information (Correct)
» Data
» Entity

» Attribute

Question No: 6 ( Marks: 1)

Many developers write the

- Please choose one

- Please choose one

first and then incrementally convert each line into

» Real code & Pseudo code

» Pseudo code & Real code (Correct)

» Real code & Artificial code

» None of the given options
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Question No: 7 (Marks: 1) - Please choose one

When we buy a software package, we do not really buy it, we just by a license that allows us to

use it, the stays with the maker.

» Agreement
» Ownership (Correct)
» Membership

» Software

Question No: 8 (Marks: 1) - Please choose one

Name, Border, Source are the
» Event Handler
» Properties
» Methods

» None of the given options

of the image object.

Question No: 9 (Marks: 1) - Please choose one

Using smart editors they can automatically color different parts of statements in different colors

e.g. HTML tags in

» Green
» Grey
» Blue (Correct)

» None of the given options
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Question No: 10 (Marks: 1) - Please choose one
is in Executive team.
» Project Manager
» CEO (Correct) Page no. 296
» Team Lead

» Developer

Question No: 11 (Marks: 1) - Please choose one
Module level design and unit testing the responsibility of
» Team Lead
» Developer (Correct)
» Project Manager

» Quality Assurance Expert

Question No: 12 (Marks: 1) - Please choose one

» Executive
» Architect
» Development (Correct)

» HR
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Question No: 13  (Marks: 1) - Please choose one

waits for some time and then launch a function.

» Timeout( )
» setTimeout( ) (Correct)
» setTime()

» setTimeln()

Question No: 14 (Marks: 1) - Please choose one

Which of the following is NOT an event handler for image object?
» onAbort
» onError
» onlLoad

» onUser (Correct)

Question No: 15 (Marks: 1) - Please choose one

is a field that uniquely identifies each record stored in a table.

» Composite Key
» Primary key (Correct)
» Foreign key

» None of the given options

Question No: 16  (Marks: 1) - Please choose one
Distance learning has got a boost due to the
» Easy communication

» Online interactive contents
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» Flexibility

» All of the given options (Correct)

Question No: 17 (Marks: 1) - Please choose one

By default in a web page Hyper Link for another web page is represented as

» Blue only
» Black and Underlined
» Blue and Bold

» Blue and Underlined (Correct)

Question No: 18 (Marks: 1) - Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write

» r_number=Maths.round(8.6)
» r_numbers=Maths.rounds(8.6)
» r_number=Math.rounds(8.6)

» r_number=Math.round(8.6) (Correct)

Question No: 19 (Marks: 1) - Please choose one

Which one is the best option for designing a Medical Expert System?
» Rule Based System
» Genetic Algorithm
» Fuzzy Logic

» Neural Network
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Question No: 20 (Marks: 1) - Please choose one
Variables allow us to manipulate data through the

» Actual Value

» Reference (Correct)

» Length

» Name

Question No: 21 (Marks: 1) - Please choose one

Which is correct?

» onUnload (Correct) (P.no.245)

» onUnLoad
» onUNLOAD
» All of the above
Question No: 22 (Marks: 1) - Please choose one

Capturing events and responding to them is called
» Function Handling
» Event Handling (Correct)
» Event Procedure

» All of the given option
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Question No: 23 (Marks: 1) - Please choose one
color should be used in background for a good presentation.
» Light
» Dark (Correct)
» Red

» None of the given options

Question No: 24 (Marks: 1) - Please choose one

Which of the following symbol is used for multiple line comments in JavaScript?

> /
» //
» /* (Correct)

> /*

Question No: 25 (Marks: 1) - Please choose one
In JavaScript, what will be the result of the follwoing operation
79%3

» 0

» 1 (Correct)

> 2

> 3

Explanation:- 79 divided by 3 and remainder is 1
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Question No: 26 (Marks: 1) - Please choose one
A new cell using HTML is added in table row by

» <TC>...</TC>

» <TR>...</TR>

» <TD>...</TD> (Correct) (P.No.54)

» <NC>...</NC>

Question No: 27 (Marks: 1) - Please choose one
TCP stands for

» Total communication protocol

» Transmission control protocol (Correct)

» Transfer control protocol

» Transfer collection protocol

Question No: 28 (Marks: 1) - Please choose one
What is NOT a key factor while designing a website?
» Usability
» User-friendly
» Consistency

» Complexity (Correct)
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Question No: 29 (Marks: 1) - Please choose one

It represents the flow chart element.

» Process
» Input or Output (correct) P.no.105
» Decision

» Connector

Question No: 30 (Marks: 1) - Please choose one
Vacuum tubes were replaced by

» Punch cards

» Transistors (Correct) P.no.14

» Micro Processors

» Resistors

Question No: 31 (Marks: 1)

When does recursion occur?

Possible Answer:-

The power of recursion evidently lies in the possibility of defining an infinite set of objects by
a finite statement.

Question No: 32 (Marks: 1)
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What are the types of computer network according to the distance between nodes ?

Answer:
There are two types of networks.
1. LAN (Local Area Network)

2, WAN (Wide Area Network)

Question No: 33 (Marks: 2)

What is meant by semantic error ?

Answer:

Occur when a statement executes and has an effect not intended by the programmer and

Often times occur only in unusual & infrequent circumstances

Question No: 34 (Marks: 2)

List down the names of two array methods available in JavaScript.

Answer:
1. sort( ) [sorts elements in alphabetical order]

2, reverse( ) [Reverses the order of elements]

Question No: 35 ( Marks: 3)
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How can you define a consistent web design? Why is it needed?

Answer:

A consistent good designed website is generated for general public that allows users to
attain what they want as quickly as possible without spending much effort.

A consistent good design assists the user in recovering from errors.

Question No: 36 ( Marks: 3)

How can we include images in a web page using HTML and Java script?

Answer:
Image in HTML

<IMG src=URL, alt=text height=pixels width=pixels align="bottom|middle|top">

Image in Javascript
Images in JavaScript can be manipulated in many ways using the built-in object Image.
Additional properties to HTML are hspace, vspace & lowsrc.

Example: It can be used by many handlers like, onAbort, onLoad & onError

Question No: 37 ( Marks: 3)

The event handler attribute consists of three parts. Write about each of them.

Answer :
The identifier of the event handler

The equal sign
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A string statement enclosed in double or single quotes.

Question No: 38 ( Marks: 5)

What is a packet in the network environment? What kind of information does it contain?

Answer:

e Packet is data chopped up into pieces in a network environment.
e These packets contain information about which computer sent the data and where

the data is going.
o If a packet runs into a problem during its trip, it can attempt to find another route.
When all the packets get where they are going, the recipient computer puts them

together again.

Question No: 39 (Marks: 5)

Suppose we have a big project. Draw hierarchy of the people involved in the project?

Answer:

Please ignore small lines relating Sub Teams to subordinates due to shortage of time.
ABCD etc are connected directly to Team Lead 1,2 & 3 accordingly.

Question No: 40 ( Marks: 10)
Write down HTML and JavaScript code for the following requirements:

Declare an Array with the identifier SUBJECT having length 5. Assign following values to the
array elements:

MIS, Java, Algorithms, Databases, C++

Show all values in reverse order.
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Question No: 41 ( Marks: 10)

How instant messaging works? Write the steps involved in this process.

Answer:

The Instant Messaging services available allow us to maintain a list of people (contacts)
that we interact with regularly. We can send instant messages to any of the contacts in our
list as long as that contact is online.

Following steps are involved in IM working.

abrwnN =

No

S0

User commences the IM client.

IM client finds the IM server & logs in.

It launches communication info (IP address, etc) to the IM server.

IM server finds user’s contacts & sends him/her the communication info.

IM server also notifies the contacts that the user is online; sends his/her
communication info to them.

The user’s & the contact’s IM clients are ready to communicate directly (P2P).
As new contact has come online, IM server informs them about the user being
online & vice versa.

Multiple, real-time chat are possible.

When the user logs-off, his/her IM client informs the IM server.

. IM server wipes away the temporary file and informs the user’s contact’s about

his/her ‘offline’ status.
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FINALTERM EXAMINATION
Spring 2009 Final
CS101- Introduction to Computing (Session - 2)

The transistor is a solid state semiconductor device used for amplification and
switching, and has terminals.

» one

» two

» three

» four

Question No: 2 ( Marks: 1) - Please choose one
Blue Pacific is a name of computer.

» Mini

» Desktop

» Micro

» Super

Question No: 3 ( Marks: 1) - Please choose one
Monte Carlo algorithm is an example of

» Randomized algorithm (page.no.102)

» Greedy algorithm

» both greedy and randomized

» Heuristics

Question No: 4 ( Marks: 1) - Please choose one

A set of stand alone productivity applications designed to work together known
as

» Productivity software suites
» Compiled software

» Secure software

» Intelligent software
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Question No: 5 ( Marks: 1) - Please choose one
The most used form tag is the <input> tag.

» True
» False

Question No: 6 ( Marks: 1) - Please choose one

What is the key feature of computer which is against human nature.?
Can’t get bored.

» Can’t get bored.

» Pattern recognition

» Repetition

» None

Question No: 7 ( Marks: 1) - Please choose one
was designed as a replacement for typewriter

» Spreadsheet Software

» Word Processor Software

» Presentation Software

» Database Software

Question No: 8 ( Marks: 1) - Please choose one

Forms can be submitted by using different methods
> 2

> 3

> 4

» 5

Methods are GET and POST

Question No: 9 ( Marks: 1) - Please choose one

To display a checkbox on the web page, we use ____ tag
» CHECKBOX

» CHECK

» INPUT

» INPUTBOX

Checkbox is not not a tag, input is a tag,

Question No: 10 ( Marks: 1) - Please choose one
attribute of FORM tag is used to mention a URL when the form is being
submitted
» name
» action
» method
» submit
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Question No: 11 ( Marks: 1) - Please choose one

You can from/to a website containing interactive forms.
» Only read

» Only write

» Read and write

» Not read and write

Question No: 12 ( Marks: 1) - Please choose one
Using COLSPAN, number of rows of the current cell should extend itself None of
the given choices

» Upward

» Downward (page.no.56)

» Both Upward and Downward
» None of the given choices

Question No: 13 ( Marks: 1) - Please choose one

ASCII WHITE is the fastest Super computer which can perform ___ calculations
in one second.

» 1.3 billion

» 1.3 trillion

» 1.3 miillion

» 1.3 thousand

Question No: 14 ( Marks: 1) - Please choose one

______is arelated collection of WWW files that includes a beginning file called a
homepage

» HTML

» Website

» HTTP

» Web page

Question No: 15 ( Marks: 1) - Please choose one
If a computer could pass the Turing test then it would be able to:

» think like human beings
» do the things faster

» win a million dollar prize
» store more information

Question No: 16 ( Marks: 1) - Please choose one
The key strengths of computers are -

» Speed

» Storage

» Do not get bored

» All of the given choices
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Question No: 17 ( Marks: 1) - Please choose one
Compared to vacuum tubes, Transistors offer:

» Much smaller size

» Better reliability

» Much lower cost

» All of the given choices

Question No: 18 ( Marks: 1) - Please choose one
Which of the following is NOT a component of IC?
» Transistors

» Diodes

» Resistors

» Vacuum tubes
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Question No: 19 ( Marks: 1) - Please choose one

When we use <INPUT type="password”>, what will happen?

» Text will not be visible
» Text will be in normal format
» Text will be in **** format

» Text will be in #### format

Question No: 20 ( Marks: 1) - Please choose one
Spread sheet is a type of _ Mathematical software
» Productivity software

» Engineering software

» Mathematical software

» Business software

Question No: 21 ( Marks: 1) - Please choose one
Word Processorisa ___ Application Software
» System Software

» Application Software

» Device

» Utility

Question No: 22 ( Marks: 1) - Please choose one

Utility Program refers to the firmware code which is run by an IBM compatible

PC when first powered on.
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» DOS
» BIOS
» Ultility Program
» None of these

Question No: 23 ( Marks: 1) - Please choose one
A computer program that facilitates the communication between the computer
and a peripheral device is called Language Translator

» Operating system

» Ultilities

» Language Translator
» Device Drives

Question No: 24 ( Marks: 1) - Please choose one

In JavaScript, what will be the result of the following operation 79%3
» 0

> 1

> 2

> 3

If we divide 79 by 3 ,we will get remainder=1 ,

Question No: 25 ( Marks: 1) - Please choose one
Which of the following number system is used by microprocessor?

» Binary

» Decimal

» Octal

» Hexadecimal

Question No: 26 ( Marks: 1) - Please choose one
Web site is collection of related

» Web pages

» Information

» Search Engines

» None of the given choices

Question No: 27 ( Marks: 1)
What BIOS stands for? — Binary Input Output System

Question No: 28 ( Marks: 1)

List down the Analytical Engine's components name (any two)
Answer : Google & Netscape,
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Question No: 29 ( Marks: 2)

Why uploading a web page is important? Describe in 2 — 3 lines.

Answer : By only uploading webpage we could place our information in order the
other can reach up to ready what we load, upload means make available our
data or information for the world web browsers

Question No: 30 ( Marks: 3)

What is the difference between microprocessors and microcontrollers? Give one
example of both.

Answer : The microprocessor is electronic equipment which can perform several
function and also processing of data and information present in a computer, while
microcontroller can only perform one function for that its design

Example

Microprocessors _ Pentium 4

Microcontroller _ can be a switch in side the washing machine

Question No: 31 ( Marks: 5)

Differentiate uni-Processor OS from Multi-Processor OS.

Answer : The Multiprocessors is when more than one processor is under
operation it can be several or may hundreds of the kind to perform one great
operation or calculation, while our PC is a kind of uni-processor

Question No: 32 ( Marks: 5)

Why do we call JavaScript an Object-based Language?

Answer : Java Script is a language by which we are writing our web-pages, this
language is designed to work for web pages
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FINALTERM EXAMINATION
Spring 2009 Final

CS101- Introduction to Computing (Session - 2)

Question No: 1 (Marks: 1) -Please choose one
---------- was known as “mill” in Analytical engine.

» Memory

» Processor

» Monitor

» Mouse
Ref: An arithmetical unit (the "mill") would be able to perform all four arithmetic
operations, plus comparisons and optionally square roots. Initially it was
conceived as a difference engine curved back upon itself, in a generally circular
layout, with the long store exiting off to one side.

Question No: 2 (Marks: 1) -Please choose one
First electronic computer was

» ABC (Page No. 14)

» UNVAC 1

» Harvard Mark 1

» IBM PC

Question No: 3 (Marks: 1) -Please choose one
What is NOT a key factor while designing a website?
» Usability
» User-friendly
» Consistency
» Complexity

Question No: 4 (Marks: 1) -Please choose one
What happens if | start a new list without closing the original one?

» An error will be generated

» A nested list will be created

» Previous list will end and a new will start.
» Nothing will happen

Question No: 5 (Marks: 1) -Please choose one
The most upper right pixel of the screen is of color.
» Any
» Red
» Green
» Blue
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Question No: 6 (Marks: 1) -Please choose one
A single pixel can acquire approximately color schemes.

» 1 million

» 2 million

» 10 million

» 16 million (P.NO.235)

Question No: 7 (Marks: 1) -Please choose one

The idea of Neural Networks field is based upon

» Human nature
» Human brain

» Human culture
» Human actions

Question No: 8 (Marks: 1) -Please choose one
Which one of the following is an application for artificial intelligence?

» Robotic

» Web Agent

» Decision Support System
» All of the given options

Question No: 9 (Marks: 1) -Please choose one
Register is a kind of memory

» Fast
» Super fast
» Slow
» Very slow

Question No: 10 ( Marks: 1) -Please choose one
Which of the following is a true statement?

» Flat-file storage is better than tabular storage.

» Tabular storage is better than flat-file storage. (Page. No 257)
» Flat-file storage is better than relational storage.

» None of the given options

Question No: 11 (Marks: 1) -Please choose one
substring(n, m) returns a string containing characters copied from position n

to

> m-2

» m -1 (Page.no. 270)
> m+1

> m
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Question No: 12 (Marks: 1) -Please choose one
The is the old profession which is being eliminated because of
computing.

» Typist

» Bank manager

» Operational manager

» All of the given options

Question No: 13 (Marks: 1) -Please choose one
The system that manages relational database, is called
» None of the given options
» Database Management System
» Data Management System
» Relational Database Management System (page.no.274)

Question No: 14 (Marks: 1) -Please choose one
When web server is busy it gives the following message to the user :
» Time out
» Waiting
» Server busy
» None of the given options

Question No: 15 (Marks: 1) -Please choose one
The group of technologies concerned with the capturing, processing and
transmission of information in the digital electronic form is called

» Telecom Engineering

» Computer Engineering

» Computer Science

» Information Technology (page.no.295)

Question No: 16 ( Marks: 1) -Please choose one

» Architecture (page.no.300)
» Business Development

» Configuration Management
» Developer

Question No: 17 (Marks: 1) -Please choose one
TCP stands for

» Transfer Center protocol

» Transmission Control Protocol (page.no.317)
» Transmission Center Protocol

» Telephone Center Protocol
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Question No: 18 (Marks: 1) -Please choose one
A collection of data organized in such a way that the computer can quickly
search for a desired data item is known as :

» Retrieving

» Database (page.no.321)

» Information

» DBMS

Question No: 19 (Marks: 1) -Please choose one
Microsoft Word is a type of:

» System Software

» Freeware Software

» Shrink-Wrapped Software (page.no.64)

» Custom-built Software

Question No: 20 (Marks: 1) -Please choose one
Users , how things work.

» Analyze in detail

» Muddle through (page.no.170)

» Figure out

» Read in detail

Question No: 21 (Marks: 1) -Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping
» RGB and Dithering
» RGB, Color mapping and Dithering
» Color mapping and Dithering (page.no.235)

Question No: 22 (Marks: 1) -Please choose one
Hardware malfunctions is related to

» Data updates

» Data integrity (page.no.253)

» Data security

» Data accessibility

Question No: 23 (Marks: 1) -Please choose one
If incorrectly we enter the negative age it is check by

» Limit Integrity (page.no.253)

» Type Integrity

» Referential Integrity

» Physical Integrity

Question No: 24 (Marks: 1) -Please choose one

Which is the user-friendly way of presenting data ?
» Query
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» Form
» Report
» All of the given options

Question No: 25 (Marks: 1) -Please choose one
Currently the BlueRay DVD can store more than of data.
» 10 GB
» 100 GB
» 50 GB (page.no.305)
» 150 GB

Question No: 26 ( Marks: 1) -Please choose one
In JavaScript, a || b isinterpreted as

» ais true or b is false

» ais true and b is true

» ais false and b is true

P ais true or b is true or both are true (page.no.148)

Question No: 27 (Marks: 1) -Please choose one
Speakers fall into the hardware category.

» True

» False

Question No: 28 (Marks: 1) -Please choose one
onBlur event is occurred for a form element when it

» Gets focus

» Losts focus (page.no.230)
» Some thing is typed in

» onBlur is not an event

Question No: 29 (Marks: 1) -Please choose one
You can view a 3-D image on a
» 3-D display
» 2-D display
» On both 2-D and 3-D displays
» \We can not view a 3-D image

Question No: 30 (Marks: 1) -Please choose one
Module level design and unit testing is the responsibility of
» Team Lead
» Developer (page.no.298)
» Project Manager
» Quality Assurance Expert

Question No: 31 ( Marks: 1)
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What is heuristic?

Common sense Lesson drawn from experience

(Artificial) Intelligent Systems

SW programs or SW/HW systems designed to perform complex tasks employing
strategies that mimic

some aspect of human thought

or

e acommonsense rule (or set of rules) intended to increase the probability
of solving some problem

o of or relating to or using a general formulation that serves to guide
investigation

Question No: 32 ( Marks: 1)
In programming, what is an object ?

Object: A named collection of properties (data, state) & methods (instructions,
behavior)

Question No: 33 ( Marks: 2)

What is spreadsheet? List any two jobs that it can do.

A spreadsheet is a grid that organizes data into columns and rows. Spreadsheets
make it easy to display

information, and people can insert formulas to work with the data.

Electronic replacement for ledgers
Charts
financial-forecasting

Question No: 34 ( Marks: 2)
In JavaScript, what is event handling? What are the two types of events?

Capturing events and responding to them

The system sends events to the program and the program responds to them as
they arrive

Events can include things a user does - like clicking the mouse - or things that
the system itself does -

like updating the clock.

Question No: 35 ( Marks: 3)
Explain how many ways businesses monitor their employees?
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» Systems are available that monitor almost every key stroke that an employee
makes on a computer

» Systems are available that read and censor all incoming and outgoing eMail
* It is quite straight forward to monitor where you surf, and when

Question No: 36 ( Marks: 3)
What is difference between Design and System Architecture?

Only the higher level designs are called System Architecture and lower
level designs can not be called system Architecture, and we can also say
the every Architecture can be called design but every design can not be
called Architecture. (For Reference Listen Lecture No.24)

Question No: 37 ( Marks: 3)

What are the Sub categories of Artificial Intelligence? Briefly explain any
two.

Expert systems

Systems that, in some limited sense, can replace an expert

Robotics

Automatic machines that perform various tasks that were previously done by
humans

Example:

Pilot-less combat air planes

Decision Support Systems:

Interactive software designed to improve the decision-making capability of their
users

Utilize historical data, models to solve problems

Question No: 38 (Marks: 5)

How many ways are there to call a function in a program ? Explain with
example

Functions do not run automatically. When the page loads, each function waits
quietly until it is told to run

Calling a Function From an Event Handler

An event handler is a command which calls a function when an event
happens, such as the user clicking a button.

The command is written in the format onEvent, where Event is the
name for a specific action. Here are some common examples:

Calling a Function From Another Function
function doSomething() {
doSomethingElse(); // This line calls the next function

}
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Question No: 39 ( Marks: 5)

Elaborate the ‘+’ operator and its constraints with the help of examples
The “+” String Operator

The “+” operator can be used to concatenate two strings

title = “bhola” + “continental”

The value of the variable title becomes “bholacontinental”

Question No: 40 ( Marks: 10)

Write a JavaScript program having two functions sum and mean.

The web page will ask the user to enter five values to be added.

After taking input it will calculate the sum and mean of those values by
calling sum and mean functions.

Question No: 41 ( Marks: 10)
Define the following terms.
Object
A named collection of properties(data, state) & methods (instructions,
behavior)
Event Handler
An event handler is a command which calls a function when an event

happens, such as the user clicking a button
Local Variable
Declaring variables (using the var keyword) within a function, makes them
local*They are available only
within the function and hold no meaning outside of it
Scope of Variable
Defining the space in which a variable is effective is known as
defining the scope of a variable. A variable can be either local or global in
scope
Array
An indexed list of elements
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing (Session - 3)
Time: 120 min
Marks: 75
Question No: 1 (Marks: 1) -Please choose one

First computer network was

» NSFNET
» FIRSTNET
» ARPANET

» ORPHANET

Question No: 2 (Marks: 1) -Please choose one

In a good presentation each slide should contain

» Heading
» Phrases not sentences
» Sentences not phrases

» Heading, sentences not phrases

Question No: 3 (Marks: 1) -Please choose one

A function is also called
» Sub-program

» Procedure
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» Sub-routine

» All of the given option

Question No: 4 (Marks: 1) -Please choose one

A single pixel can acquire approximately color schemes.

» 1 million
» 2 million
» 10 million

» 16 million

Question No: 5 (Marks: 1) -Please choose one
Which of the following is NOT a Loop statement?

» For

» While

» Switch

» Do-While

Question No: 6 (Marks: 1) -Please choose one

Which one of the following is NOT a component of Rule Based System?
» Rule Compiler
» Rule Interpreter
» Rules Base

» Working Memory
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Question No: 7 (Marks: 1) -Please choose one

Spread sheet is a type of

» Productivity software

» Engineering software

» Mathematical software

» Business software

Question No: 8 (Marks: 1) -Please choose one

A combination of word processing and graphic design is

» Corel Draw
» Desktop Publishing
» Paint

» WordPad

Question No: 9 (Marks: 1) -Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write

» r_numbers=Maths.rounds(8.6)
» r_number=Math.rounds(8.6)
» r_number=Math.round(8.6)

» r_number=Maths.round(8.6)
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Question No: 10 ( Marks: 1) -Please choose one
Which of the following is a true statement?
» Flat-file storage is better than tabular storage.
» Tabular storage is better than flat-file storage.
» Flat-file storage is better than relational storage.

» None of the given options

Question No: 11 (Marks: 1) -Please choose one

The political process is also influenced by the use of

» Discussion forums
» Newsgroups
» Mailing lists

» All of the given options http://lvustudents.ning

Question No: 12 (Marks: 1) -Please choose one

The system that manages relational database, is called

» None of the given options
» Database Management System
» Data Management System

» Relational Database Management System
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Question No: 13 (Marks: 1) -Please choose one

DBMS supports data in terabytes.

» Personal
» Desktop
» Enterprise

» Single-user

Question No: 14 (Marks: 1) -Please choose one
Trinoo is a software.

» DoS

» Scanning

» Utility

» None of the given options

Question No: 15 (Marks: 1) -Please choose one
What is the major problem with flash based website?

» Its two heavy

» Cannot be indexed

» Less attractive

» Inaccessible

http://vustudents.ning.com

70




Question No: 16 ( Marks: 1) -Please choose one

The organization is the collection of

» Peoples
» Professionals
» Teams

» Individuals

Question No: 17 (Marks: 1) -Please choose one

The tasks performed to determine the existence of defects is called
» Debugging
» Testing
» Repairing

» Coding

Question No: 18 (Marks: 1) -Please choose one

Many developers write the first and then incrementally convert each
line into

» Real code & Pseudo code
» Pseudo code & Real code
» Real code & Artificial code

» None of the given options
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Question No: 19 (Marks: 1) -Please choose one

Forms can be submitted through & methods

» INCLUDE, POST
» INCLUDE, GET
» GET, POST

» SEND, POST

Question No: 20 (Marks: 1) -Please choose one

If an algorithm is syntactically correct, but semantically incorrect then this
situation is

» Very good situation
» Very dangerous situation
» Not very bad

» Neutral situation

Question No: 21 (Marks: 1) -Please choose one
Heuristics lead to the best results.

» Sometimes

» Do not

» Occasionally

» Not always http://lvustudents.ning
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Question No: 22 (Marks: 1) -Please choose one

In TCPIP communication fragmentation is responsibility of
» TCP
> IP
» Both TCP and IP

» Internet

Question No: 23 (Marks: 1) -Please choose one
Access to the internet became easy after the invention of
» WWW & Web Browsers
» Mainframes
» Binary system

» Signals

Question No: 24 (Marks: 1) -Please choose one
Which one is the example of spreadsheet software ?

» MS Word

» MS PowerPoint

» MS Excel

» MS Access

Question No: 25 (Marks: 1) -Please choose one

User can remotely log on to a computer and can have a control over it like a
local user using
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» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP

» TCP/IP and FTP

Question No: 26 (Marks: 1) -Please choose one
If incorrectly we enter the negative age it is check by

» Limit Integrity

» Type Integrity

» Referential Integrity

» Physical Integrity

Question No: 27 (Marks: 1) -Please choose one
------------------ is a digital programmable mechanical machine
» Analytical Engine
» Difference Engine
» Harvard Mark 1

» Mechanical engine

Question No: 28 (Marks: 1) -Please choose one

This element of Flow Chart is called

» Process

» Off page connector
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» Decision

» Connector

Question No: 29 (Marks: 1) -Please choose one
In a library’s database, if there is an entry in the register for Book # 423 then
the corresponding Book must actually exist; is an example of which type of
data integrity:

» Type integrity

» Limit integrity

> Physical Integrity

> Referential Integrity

Question No: 30 (Marks: 1) -Please choose one
Ada is a programming language specifically designed for
» Analytical Engine
» Difference Engine
» Harvard Mark 1

» Mechanical engine

Question No: 31 ( Marks: 1)
What are the elements of website design? Any one
Question No: 32 ( Marks: 1)

What does TCP/IP stand for?
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Question No: 33 ( Marks: 2)

What is the database?

Question No: 34 ( Marks: 2)

What is the use of Default keyword in switch structure?

Question No: 35 ( Marks: 3)

How can we include images in a web page using HTML and Java script?
Question No: 36 ( Marks: 3)

Where "While" loop is more preferable than "For" loop and vice versa ? , explain
with the help of example.

Question No: 37 ( Marks: 3)

What do you mean by FTP or File Transfer Protocol?

Question No: 38 (Marks: 5)

Differentiate between For and While loop by writing the syntax of both loops.
Question No: 39 (Marks: 5)

Write JavaScript code for the following:  http://vustudents.ning

Make a function compareWithTen(value)

Compare the function argument with ‘10’ and display a message whether the
value is less than, equal to or greater than 10.

Question No: 40 ( Marks: 10)

What is the problem with Relational Database and what solution you can
suggest for it?

Question No: 41 ( Marks: 10)
Develop a web page that displays six thumbnail images. A main image should

change to a larger version of the thumbnail as soon as the mouse moves over a
thumbnail image. Write complete HTML and JavaScript code.
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing
Time: 120 min
Marks: 75
Question No: 1 ( Marks: 1) - Please choose one
Cray-1 was first commercial computer
» Super
» Mini
» Micro
» Personal

Question No: 2  ( Marks: 1) - Please choose one

To improve the time for scannig a web page, text should be

» Centered
» Left Aligned
» Right Aligned

» Staggered

Question No: 3  ( Marks: 1) - Please choose one

% of the users have left websites in frustration due to poor
navigation.

> 40
> 62
> 83

> 91

http://vustudents.ning.com 77




Question No: 4  ( Marks: 1) - Please choose one

routes packets through the internet to get them to their destination.

» FTP
» HTTP
» TCP
> IP

Question No: 5 ( Marks: 1) - Please choose one

A variable can be in scope.
» Local
» Global
» Either local or global

» None of the given options

Question No: 6  ( Marks: 1) - Please choose one

<UL> tag is used to
» underline text
» end the line
» create ordered list

» create unordered list
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Question No: 7  ( Marks: 1) - Please choose one

The reserved word allows a determined action to be taken if the
first condition is false.

» For
» While
» Else

» Switch

Question No: 8 ( Marks: 1) - Please choose one

Word Processor is a

» System Software
» Application Software
» Device
» Utility
Question No: 9  ( Marks: 1) - Please choose one

Automatic machines performing various tasks that were previously done by
humans, are called

» Robotics
» Computers
» Decision Making Systems

» Autonomous Web Agents
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Question No: 10  ( Marks: 1) - Please choose one

In tabular storage, fields placed in a particular row are strongly

» Independent

» Dependent

» Interrelated

» Inconsistent
Question No: 11 ( Marks: 1) - Please choose one
country="Hello Pakistan”;
document.write(country.length);

The out put of the above statement is

> 12
» 13
> 14
» 15
Question No: 12  ( Marks: 1) - Please choose one

Due to working at home, contact with the colleagues is , which may
resultin quality of work

» Reduced, Poorer
» Reduced, Better
» Increased, Poorer

» Increased, Better
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Question No: 13  ( Marks: 1) - Please choose one

Spies of one business monitoring the network traffic of their competitors’

» Industrial Intelligence
» Industrial Espionage
» Industrial Spying

» Industrial Surveillance

Question No: 14  ( Marks: 1) - Please choose one

Unlike virus, is a stand-alone program.

» Trojan horse
» Logic bomb
» Worm

» Time bomb

Question No: 15  ( Marks: 1) - Please choose one

Planning and tracking of the project is the responsibility of the

» Architect
» Team Lead
» Developer

» Chief Executive Officer
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Question No: 16  ( Marks: 1) - Please choose one

is in Executive team.

» Project Manager
» CEO
» Team Lead
» Developer
Question No: 17  ( Marks: 1) - Please choose one
team is responsible for the maintenance, expansion ,

improvement of the infrastructure consisting of workstations, networking
equipment, software and network security.

» Support
» Configuration Management
» Quality Assurance

» Developer

Question No: 18  ( Marks: 1) - Please choose one

Using smart editors they can automatically color different parts of statements in

different colors e.g. HTML tags in color.

» Green
» Grey
» Blue

» None of the given options
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Question No: 19  ( Marks: 1) - Please choose one

Structures, in which another list starts before the first list is finished, are called:

» Multiple Lists

» Nested Lists

» Ordered Lists

» Un-ordered Lists

Question No: 20 ( Marks: 1) - Please choose one

Microsoft Word is a type of:

» System Software
» Freeware Software
» Shrink-Wrapped Software
» Custom-built Software
Question No: 21 ( Marks: 1) - Please choose one

To display a radio button on the web page, we use __ tag

» INPUTBUTTON
> INPUT
» RADIOBUTTON

» RADIO
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Question No: 22  ( Marks: 1) - Please choose one

Flow control constructs in JavaScript includes:

» If-Else
» Loops and If -Else
» Switch and If-Else
» All of the given choices
Question No: 23  ( Marks: 1) - Please choose one
Which is NOT true for JavaScript variable name ?
» Student
» Roll_no_1111
» For

» schedule

Question No: 24  ( Marks: 1) - Please choose one

In JavaScript, first element of an array has the index:

> 1
> -1
> 2

» None of the given choices
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Question No: 25 ( Marks: 1) - Please choose one

In flat-file databases each record was separated by a special character named :
» Horizontal bar
» Vertical bar
» Text bar

» Character bar

Question No: 26  ( Marks: 1) - Please choose one

JavaScript function fixed() has equivalent HTML tag-set

> <FIX>........ </FIX>
> <F> ... </F>

» <PRE>............. </PRE>
> <H> .. ... </H>

Question No: 27  ( Marks: 1) - Please choose one

74HC163 has two enable input pins which are and

» ENP, ENT
> ENI, ENC
» ENP, ENC

> ENT, ENI
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Question No: 28  ( Marks: 1) - Please choose one

software directly interacts with the hardware.

» Application software
» System software
» Dynamic software

» Distributed software

Question No: 29  ( Marks: 1) - Please choose one

From which of the following is NOT a technique through which Security can be
improved :

» Private or virtual-private networks
» Firewalls

» Metal detectors

» Virus detectors

Question No: 30  ( Marks: 1) - Please choose one

<script>
Number=new Array(5);
for(var i=1; i<=5; i=i+1)

{
for( var k=6; k<=10; k=k+1)
{
Numberl[i]= k*i;
}
¥
</script>
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For how many times the Nested For Loop shall execute;

» 20

» 15

» 25

» Shall terminate in first loop.
Question No: 31  ( Marks: 1)
What does NIC stand for?

Question No: 32  ( Marks: 1)

Name any software which can be used to make a presentation.

Question No: 33  ( Marks: 2)

How JavaScript Arrays are heterogeneous ?

Question No: 34  ( Marks: 2)

What is the database?

Question No: 35 ( Marks: 3)

Differentiate between LAN and WAN with one example of each.

Question No: 36  ( Marks: 3)

What are Trojan Horses ?
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Question No: 37  ( Marks: 3)

What do you mean by FTP or File Transfer Protocol?
Question No: 38  ( Marks: 5)

In which situation, we use:

i- switch construct

ii- multiple If-else construct

Question No: 39  (Marks: 5)
What are the responsibilities and profile of a Team Lead?
Question No: 40  ( Marks: 10)

Give any five well-known design heuristics for architectural design.

Question No: 41  ( Marks: 10)

Is tabular data storage better than flat file data storage? Justify your answer.
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FINALTERM EXAMINATION
Fall 2009

CS101- Introduction to Computing (Session - 1)

Time: 120 min

Marks: 75

Question No: 1 (Marks: 1) -Please choose one

A protocol used for receiving email messages is called

» URL
» Telnet
» POP3

» SMTP

Question No: 2 (Marks: 1) -Please choose one
The browser breaks down the URL into parts.
> 2
>3
> 4

» 5
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Question No: 3 (Marks: 1) -Please choose one
Which one of the following is NOT a primary color?

» Red

» Green

> Yellow

» Blue

Question No: 4 (Marks: 1) -Please choose one

A combination of word processing and graphic design is

» Corel Draw
» Desktop Publishing
» Paint

» WordPad

Question No: 5 (Marks: 1) -Please choose one

Automatic machines performing various tasks that were previously done by
humans, are called

» Robotics
» Computers
» Decision Making Systems

» Autonomous Web Agents
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Question No: 6 (Marks: 1) -Please choose one

can be used for entering, editing, or viewing data, one record at a
time.

» Queries
» Forms
» Reports
» None of the given options
Question No: 7 (Marks: 1) -Please choose one

random() function returns a randomly-selected, floating-point number between

» 0 and 1
» 0and 10
» 0 and -10

» 0and -1

Question No: 8 (Marks: 1) -Please choose one

When'+’ operator is used with string operands, it both strings.

» Adds
» Subtracts
» Concatenates

» Compares
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Question No: 9 (Marks: 1) -Please choose one

Due to working at home, contact with the colleagues is , which may
result in quality of work

» Reduced, Poorer

» Reduced, Better

» Increased, Poorer

» Increased, Better
Question No: 10 (Marks: 1) -Please choose one
What is the 2nd step of DoS attack?

» Race

» Arm

» Search

» Attack

Question No: 11 (Marks: 1) -Please choose one

The Information technology has three components

» Telecom Engineering, Network Engineering, Computer Science
» Telecom Engineering, Computer Engineering, Computer Science
» Telecom Engineering, Computer Engineering, Database Engineering

» Telecom Engineering, Computer Engineering, Hardware Engineering
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Question No: 12 ( Marks: 1) -Please choose one

The developer report to in a development team.

» Team Lead
» Project Manager
» CEO

» IT Manager

Question No: 13 (Marks: 1) -Please choose one
There are types of errors.

> 2

>3

> 4

> 5

Question No: 14 (Marks: 1) -Please choose one

TCP stands for

» Transfer Center protocol
» Transmission Control Protocol
» Transmission Center Protocol

» Telephone Center Protocol
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Question No: 15 (Marks: 1) -Please choose one

When the packets reach at destination, reassembles them into
original message.

» Protocol
» TCP
» IP

» NIC

Question No: 16 ( Marks: 1) -Please choose one

Which one of these is NOT an example of embedded computers?
» IMB PC
» Microwave oven
» Refrigerator

» Calculator

Question No: 17 (Marks: 1) -Please choose one

A translates a high-level language (that is easy to understand for
humans) into a language that the computer can understand

» Computer
» Transistor
» Compiler

» Device
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Question No: 18 ( Marks: 1) -Please choose one

is a related collection of WWW files that includes a beginning file called
a homepage

» HTML
» Website
» HTTP

» Web page

Question No: 19 (Marks: 1) -Please choose one
To display a radio button on the web page, we use __ tag
» INPUTBUTTON
» INPUT
» RADIOBUTTON

» RADIO

Question No: 20 ( Marks: 1) -Please choose one

Randomized algorithms are often than deterministic algorithms for the
same problem.

» Simpler and more slow
» Simpler and more efficient
» Complex and more efficient

» Complex and more slow
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Question No: 21 (Marks: 1) -Please choose one
Flow control constructs in JavaScript includes:

» If-Else

» Loops and If -Else

» Switch and If-Else

» All of the given choices

Question No: 22 (Marks: 1) -Please choose one
is also known as System Architecture
» High level system design
» Low level system design
» Every system design

» Software Requirement

Question No: 23 (Marks: 1) -Please choose one
Functions are also called:

» Heuristics

» Variables

» Arrays

» Subprograms
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Question No: 24 (Marks: 1) -Please choose one

Which event handler executes the specified JavaScript code when a
window/form element loses focus ?

» onBlur
» onlLoad
» onUnload

» onFocus

Question No: 25 (Marks: 1) -Please choose one

User can remotely log on to a computer and can have a control over it like a
local user using

» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP

» TCP/IP and FTP

Question No: 26 (Marks: 1) -Please choose one

_______isthe process of analyzing large databases to identify patterns.
» Data normalization
» Data management
» Data Mining

» None of the given options

http://vustudents.ning.com 97




Question No: 27 (Marks: 1) -Please choose one

are powerful pieces of hardware, but not much useful on

their own.
» Microcontrollers
» Microprocessors
» Integrated circuits

» Ports

Question No: 28 (Marks: 1) -Please choose one

You can view a 3-D image on a

» 3-D display
» 2-D display
» On both 2-D and 3-D displays

» We can not view a 3-D image

Question No: 29 (Marks: 1) -Please choose one

From which of the following is NOT a technique through which Security can be
improved :

» Private or virtual-private networks
» Firewalls
» Metal detectors

» Virus detectors
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Question No: 30 (Marks: 1) -Please choose one
In a library’s database, if there is an entry in the register for Book # 423 then
the corresponding Book must actually exist; is an example of which type of
data integrity:

» Type integrity

» Limit integrity

» Physical Integrity

»  Referential Integrity

Question No: 31 ( Marks: 1)
What does NIC stand for?

Answer: Network Interface Cards.

Question No: 32 ( Marks: 1)
Why there is a need to use primary key in database ?

Answer: Primary Key is a field that uniquely identifies each record stored in a
table.

Question No: 33 ( Marks: 2)

What is internet?

Question No: 34 ( Marks: 2)

What is the database?

Question No: 35 ( Marks: 3)

The event handler attribute consists of three parts. Write about each of them.
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Question No: 36 ( Marks: 3)

Where "While" loop is more preferable than "For" loop and vice versa ? , explain
with the help of example.

Question No: 37 ( Marks: 3)

Write JavaScript code to convert the number 236.2363611111556 into currency
format and JavaScript statement to show output.

Question No: 38 ( Marks: 5)

What is the TCP/IP? How it works ?

Question No: 39 (Marks: 5)
Write a short note on:
a. Good programming methodology?

b. Correct program
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Question No: 40 ( Marks: 10)

Write down JavaScript functions that is equivalent to the following HTML code?

HTML code JavaScript function

<FONT size=18>

</[FONT>

<FONT color="blue”>

</FONT>

<PRE> ... </PRE>

<A href=URL> ...</A>

<BIG> ... </BIG>

<SMALL> ... </SMALL>

<SUB> ... </SUB>

<SUP> ... </SUP>

<B> ... </B>

<|>...</I>

Question No: 41 ( Marks: 10)

What are other virus like programs?
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FINALTERM EXAMINATION
Fall 2009

CS101- Introduction to Computing (Session - 1)

Question No: 1 (Marks: 1) -Please choose one
Cray-1 was first commercial computer

» Super

» Mini

» Micro

» Personal
Question No: 2 (Marks: 1) -Please choose one
The name of first browser was

» Internet Explorer

» Moziac

» Netscape

» Firefox

Question No: 3 (Marks: 1) -Please choose one
The impact of a digit in a number is determined by its ---------------
» Value
» Location
» Length

» None of above
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Question No: 4 (Marks: 1) -Please choose one

First computer network was

» NSFNET
» FIRSTNET
» ARPANET

» ORPHANET

Question No: 5 (Marks: 1) -Please choose one
A variable can be in scope.

» Local

» Global

» Either local or global

» None of the given options

Question No: 6 (Marks: 1) -Please choose one

color should be used in background for a good presentation.

» Light
» Dark
» Red

» None of the given options
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Question No: 7 (Marks: 1) -Please choose one

Which one of the following is not an event handler's attribute?
» Function
» |dentifier
» Equal sign

» String consisting of JavaScript statements

Question No: 8 (Marks: 1) -Please choose one

Variables allow us to manipulate data through the

» Actual Value
» Reference
» Length

» Name

Question No: 9 (Marks: 1) -Please choose one

Which one of the following is NOT a component of Rule Based System?
» Rule Compiler
» Rule Interpreter
» Rules Base

» Working Memory
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Question No: 10 ( Marks: 1) -Please choose one

Fuzzy logic is based on

» Ground facts
» Experience
» Practice

» Approximation

Question No: 11 (Marks: 1) -Please choose one

a = Math.ceil(12.01)

What will be the value of a ?

> 12
> 13
» 12.0

» 13.01

Question No: 12 (Marks: 1) -Please choose one

Tag used to make a Text Bold is

» <BOLD></BOLD>
p <B></B>
» <BODY></BODY>

» None of these
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Question No: 13 (Marks: 1) -Please choose one

<P> </P> and <BR> tags are not same because

» <p></p> goes to the next line
» <BR> goes to the next after next line
» <P></P> goes to the next after next line
» Both are same
Question No: 14 (Marks: 1) -Please choose one

Event handlers are placed in the portion of a Web page as
attributes in HTML tags.

» HEAD
» BODY
» SCRIPT

» TITLE

Question No: 15 ( Marks: 1) -Please choose one

Due to working at home, lack of interaction may result in
professional growth.

» Slower
» Faster
» Higher

» Improved
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Question No: 16 ( Marks: 1) -Please choose one

DBMS supports data in terabytes.

» Personal
» Desktop
» Enterprise

» Single-user

Question No: 17 (Marks: 1) -Please choose one

waits for some time and then launch a function.

» Timeout( )
» setTimeout( )
» setTime()

» setTimeln()

Question No: 18 (Marks: 1) -Please choose one

The responsibilities of the Team Lead includes

» Planning and tracking of the project
» Detailed design
» Professional development of team members

» All of the given options
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Question No: 19 (Marks: 1) -Please choose one
is also known as System Architecture
» High level system design
» Low level system design
» Every system design

» Software Requirement

Question No: 20 (Marks: 1) -Please choose one
The key property of the ‘Array’ object in JavaScript is

» Value

» Length

» Name

» All of the given choices

Question No: 21 (Marks: 1) -Please choose one
There are ways of calling functions.

» One

» Two

» Three

» Four
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Question No: 22 (Marks: 1) -Please choose one

Which event handler executes the specified JavaScript code when a
window/form element loses focus ?

» onBlur
» onlLoad
» onUnload

» onFocus

Question No: 23 (Marks: 1) -Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping
» RGB and Dithering
» RGB, Color mapping and Dithering

» Color mapping and Dithering

Question No: 24 (Marks: 1) -Please choose one
Hardware malfunctions is related to

» Data updates

» Data integrity

» Data security

» Data accessibility
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Question No: 25 (Marks: 1) -Please choose one

Users communicate with the computer using a consistent user interface
provided by the OS.

» True

» False

Question No: 26 ( Marks: 1) -Please choose one
Extension for saving web page is / are;

» *.html

» *.htm

» *.html and *.htm both are in use

» None of These

Question No: 27 (Marks: 1) -Please choose one

repeatedly based on a given Boolean condition.
» For
» Do-While
> If-else

» While
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Question No: 28 (Marks: 1) -Please choose one

onBlur event is occurred for a form element when it

» Gets focus

» Losts focus
» Some thing is typed in

» onBlur is not an event

Question No: 29 (Marks: 1) -Please choose one

<script>
Number=new Array(5);
for(var i=1; i<=5 ; i=i+1)

{
for( var k=6; k<=10; k=k+1)
{
Numberli]= k*i;
}
}
</script>

For how many times the Nested For Loop shall execute;

> 20
» 15
» 25

» Shall terminate in first loop.
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Question No: 30 (Marks: 1) -Please choose one

In JavaScript: In order to display the text on browser Grade A, which of following
statement is True.

» documentwrite( "Grade A")
» document.write( "Grade A");
» document.write( "Grade” && A");

» document.write( "Grade” && “A");

Question No: 31 ( Marks: 1)
In programming, what is an object ?

Answer: It is a named collection of properties and methods.

Question No: 32 ( Marks: 1)
What kind of information can be stored in a database ?
Answer:

It can stored numbers, boleans, sound, video, images etc.

Question No: 33 ( Marks: 2)
Define the key weakness of the web?
Answer:

Initially web was designed only for humans to read not for computers to
understand it.
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Question No: 34 ( Marks: 2)

How many iterations would this ‘for’ loop run for?
for(x=50;x<0;x=x-1){

document.write ( X ) ;

}

Answer:

50 iterations

Question No: 35 ( Marks: 3)
How can we define a Pixel?
Answer:

It is the smallest element of image which is spread with regular array on display
and each element consist of particular color.

Question No: 36 ( Marks: 3)

Write JavaScript code to convert the number 236.2363611111556 into currency
format and JavaScript statement to show output.

Question No: 37 ( Marks: 3)

Write code in JavaScript to display the odd numbers between 20 to 100 using
FOR statement.
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Note: No need to write whole HTML program. Just JavaScript code of require
part is require.

Question No: 38 ( Marks: 5)

How marketing strategies are changed with the progress in computing? How
new marketing strategies are implemented?

Answer:

Marketing Strategy Changes with the new requirements of the modern era and
the applications of the business. The web has changed marketing strategy from a
mass focus to single person focus. We collected data and analyze accordingly to

find out the behavior of the market and end users. In new marketing more
advertising is being done through email and web and get feedback.

Question No: 39 ( Marks: 5)

<script>

Number = new Array(5);

or(var i=1; i<=5 ; i=i+1

for(j=0;j<5;j=j+1)
{

document.write(" "+Number[j]+"<BR>");

}

</script>

A) What should be output of above code?
B) Explain the highlighted lines of code?

Question No: 40 ( Marks: 10)
Write a brief note on each of the following.
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FTP
Telnet

Instant messaging
VolP

(SEVRORN

FTP: File Transfer Protocol: This protocol is used to upload and download the
files on remote computers.

Telnet: FTP allows file operations only while Telnet can log on to a computer of
other users through TCP/IP network and use like a local user, it help in testing of
remote web server.

Instant Messaging: This is the service of messaging provided on the internet
like MSN messenger, Yahoo messenger, through which we interact people
randomly whenever required.

VolP: Voice over IP, It is used to transmit the voice from one IP to another IP, In
which voice is first broken down and then transmitted over a network.

Question No: 41 ( Marks: 10)

What are Commonsense Guidelines to avoid viruses? Discuss about Antivirus
as well.

Answer:
Commonsense Guidelines to avoid viruses are as follows:
1. Do not open attachment of unwanted emails.
2. Don’t used copied/pirated Softwares
3. Regularly place data somewhere as backup
4.  Use Registered and Trusted Softwares only.
5. Install Antivirous in the system
6. Update your Windows and softwares with the passage of time.

7.  Scan before using any external device with your system as USB
Device.
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Antivirus:

This is the software design for preventing your system from harmful effects and
maintain the speed of computer. These softwares are available on the CD’s and
DVD’s. These softwares continuously monitor the systems and aware when any
harmful virus is detected and asked for the further operations. Some
automatically remove the viruses from the system.
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FINALTERM EXAMINATION

Fall 2009

CS101- Introduction to Computing (Session - 2)

Time: 120 min

Marks: 75

Question No: 1 (Marks: 1) -Please choose one

Human are better than computers at:

» Efficiency

» Accuracy

» Pattern recognition

» None of the given choices

Question No: 2 (Marks: 1) -Please choose one

TCP stands for

» Total communication protocol

» Transmission control protocol

» Transfer control protocol

» Transfer collection
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Question No: 3 (Marks: 1) -Please choose one

First computer network was

» NSFNET
» FIRSTNET
» ARPANET

» ORPHANET

Question No: 4 (Marks: 1) -Please choose one
A user may access any item on the web through

» URL

» Telnet

» POP

» SMTP

Question No: 5 (Marks: 1) -Please choose one

In JavaScript, a variable declaration is

» Optional
» Mandatory
» Not allowed

» None of the given
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Question No: 6 (Marks: 1) -Please choose one

According to a popular heuristic, success is defined by

» The user
» The builder
» Both user and builder

» None of the given options

Question No: 7 (Marks: 1) -Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write

» r_numbers=Maths.rounds(8.6)
» r_number=Math.rounds(8.6)
» r_number=Math.round(8.6)

» r_number=Maths.round(8.6)

Question No: 8 (Marks: 1) -Please choose one

random() function returns a randomly-selected, floating-point number between

» 0 and 1
» 0and 10
» 0and-10

» 0and -1
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Question No: 9 (Marks: 1) -Please choose one
Trinoo is a software.

» DoS

» Scanning

» Utility

» None of the given options

Question No: 10 ( Marks: 1) -Please choose one

Which attribute of the IMG tag tells us about the source of the image

» source
» path
» loc

» src

Question No: 11  ( Marks: 1) - Please choose one

The developer report to in a development team.

» Team Lead
» Project Manager
» CEO

» IT Manager
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Question No: 12 ( Marks: 1) -Please choose one

The effective way not to only write programs but also it works properly and

further more to minimize the time and the development cost of the program is

called

» Programming Mechanism
» Programming Methodology
» Programming Synchronization

» None of the given options

Question No: 13 (Marks: 1) -Please choose one
TCP stands for

» Transfer Center protocol

» Transmission Control Protocol

» Transmission Center Protocol

» Telephone Center Protocol

Question No: 14 (Marks: 1) -Please choose one

When we buy a software package, we do not really buy it, we just by a license

that allows us to use it, the stays with the maker.

» Agreement
» Ownership
» Membership

» Software
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Question No: 15 (Marks: 1) -Please choose one

Many developers write the first and then incrementally convert each
line into

» Real code & Pseudo code
» Pseudo code & Real code
» Real code & Artificial code

» None of the given options

Question No: 16 (Marks: 1) -Please choose one

Collection of facts & figures is called

» Information
» Data
» Entity

» Attribute

Question No: 17 (Marks: 1) -Please choose one

A collection of data organized in such a way that the computer can quickly
search for a desired data item is known as :

» Retrieving
» Database
» Information

» DBMS
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Question No: 18 ( Marks: 1) -Please choose one

To start an ordered list from 20 instead of 1, we will write

» <OL begin = “20">
» <OL initiate = “20">
» <OL start = “20">

» <OL from = “20">

Question No: 19 (Marks: 1) -Please choose one

Using COLSPAN, number of rows of the current cell should extend itself
» Upward
» Downward
» Both Upward and Downward

» None of the given choices

Question No: 20 (Marks: 1) -Please choose one
Microsoft Word is a type of:

» System Software

» Freeware Software

» Shrink-Wrapped Software

» Custom-built Software
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Question No: 21 (Marks: 1) -Please choose one
Compound Statement after decision constructs in JavaScript is enclosed with
> ()
>[]
>{}
>{}

Question No: 22 (Marks: 1) -Please choose one
Users , how things work.

» Analyze in detail

» Muddle through

» Figure out

» Read in detail

Question No: 23 (Marks: 1) -Please choose one

One can send an email message to a remote computer using protocol
» HTTP
» SMTP
» FTP

» TELNET
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Question No: 24 (Marks: 1) -Please choose one

Writing a response, multiple statements are separated from each other with the
help of

» Period (.)
» Comma (,)
» Colon (:)

» Semicolon ( ;)

Question No: 25 (Marks: 1) -Please choose one

With the passage of time the field of Computing and Telecommunication is

» Diverging
» Converging
» Becoming different

» Becoming unique

Question No: 26 ( Marks: 1) -Please choose one

When we have to show value as part of a whole picture, which type of chart is
used.

» Bar chart
» Pie chart
» Line graph

» None of the given
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Question No: 27 (Marks: 1) -Please choose one

» Application software
» System software
» Anonymous software

» Interactive software

Question No: 28 (Marks: 1) -Please choose one
Global variables can make the logic of a web page.

» Difficult to understand

» Easier to understand and maintain

» Difficult to reuse and maintain

» Difficult to understand, reuse and maintain

Question No: 29 (Marks: 1) -Please choose one

software directly interacts with the user.

In partitioning of program/module, it should be assured that partitioned

chunks should be as as possible.
» Dependent
» Independent
» Complex

» All of the above
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Question No: 30 (Marks: 1) -Please choose one
for(var i=1; i<=2;i=i+1)
{

document.write( "Sorted Words:" + "<BR>")

}

Which of the following shall be the output of above code:
» Sorted Words: Sorted Words:

» Sorted Words:
Sorted Words:

> Sorted Words: “<BR>"

Sorted Words: “<BR>"

» Sorted Words: <BR>

Sorted Words: <BR>

Question No: 31 ( Marks: 1)
What are the elements of website design? Any one

Ans:

Elements of webdesign: There are in 3 elements of web design and below are

there names:

1. Navigation scheme
2. Overall look and feel
3. Layout of information
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Question No: 32 ( Marks: 1)

What kind of information can be stored in a database ?

Numbers, Booleans, text
Sounds

Images

Video

Question No: 33 ( Marks: 2)

Why hub is used in networks?

HUB: Hub is networking component which can be used to connect the networks
and it can also be used to extend the size of networks.

Simply it can be explained as a common connection point for devices in a
network. It contains multiple ports like 8port, 16 port , 23 port hubs

Question No: 34 ( Marks: 2)

Write names of the DoS attack’s phases?

DoS (Denail of service): DoS attach has in total 3 phases and below they are
listed:

1. Search
2. Arm
3. Attack
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Question No: 35 ( Marks: 3)

What do you mean by FTP or File Transfer Protocol?

FTP: File transfer protocol was first introduced in 1973; it standardized the
transfer of files between computers on a TCP/IP network (e.g internet).

It can download or upload files to a remote computer using the FTP protocol

Operations performed using FTP:

1. List, change, create folders on a remote computer
2. Upload and download files

Usage: Transferring Web content from the developer’s PC to the Web server

Question No: 36 ( Marks: 3)

How many types of errors can be found during a program developement? List
them.

1. Syntax errors
2. Semantic errors
3. Run-time errors
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Question No: 37 ( Marks: 3)

Write code in JavaScript to display the odd numbers between 20 to 100 using
FOR statement.

Note: No need to write whole HTML program. Just JavaScript code of require
part is require.

Question No: 38 ( Marks: 5)

Why the number of temporary workers are on the rise? Discuss main reasons?

Temporary workers:

Temporary workers are those workers which a company can hire to perform a
certain task with in a defined time period.

Temporary workers are mostly consultants which move organization to
organization to perform assigned workers.

Reasons:

1. Now-a-days; whole world is suffering from financial crisis, most of the companies have
frozen there hiring, just in case they need a resource they are looking for a temporary
worker for a specified time span to perform a specialized task and they just pay him for
that period of time.

2. Temporary workers are mostly consultants which have expertise in a certain field and
they are considered specialists in that field.

3. Employer doesn’t need to train the temporary worker.

Question No: 39 (Marks: 5)

Write the JavaScript code for the Function SumOddNumbers(maxNumber) that
can add non-negative odd numbers up to maxNumber and return their sum.

Java Script Code:

http://vustudents.ning.com 130




Question No: 40 ( Marks: 10)

Define network organization? What are important features of network
organization? (4+6)

Network Organization :

Network organization is an interfirm organization that is characterized by organic
or informal social systems. A company or group of companies that has a
minimum of formal structures and relies instead on the formation and dissolution
of teams to meet specific objectives..

Features of Network Organization:

1. The organizations are learning that business can be done in a more effective manner if
emphasis is placed upon cooperation, shared responsibility and networking:

Within the organization

And also with their customers and suppliers

Changes according to the demand of the times

Works effectively to meet the business goals of the organization

Everyone has a feeling that he/she is playing a major role in the organization which
eventually gives a feel of ownership and because of that employee can put his best effort
to accomplish a task.

W=

Question No: 41 ( Marks: 10)

Answer the following questions by looking at the code given below.

1-  Which alert box will be displayed if variable 'marks' has value 75?
Ans: alert("Above average performance");

2- What is the range of the marks when the alert box displays the
message “Average performance”?

Ans: else if (marks > 50 && marks < 60)
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alert("Average performance");

3- What is the range of the marks when the alert box displays the
message “That's poor performance”™?

Ans: The below mentioned alert box is displayed for all the marks
less then or equal to 50

else

alert("That's poor performance");

4-  Which alert box will be displayed if variable 'marks' has the value
1007

Ans: {

alert("You've touched a century");

1. if (marks == 100)
2. {
3. alert("You've touched a century");
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4. }

5. else if (marks >= 80 && marks < 100)
6. {

7. alert("That's good");

8. }

9. else if (marks >= 60 && marks < 80)
10. {

11. alert("Above average performance");
12. }

13. else if (marks > 50 && marks < 60)
14. {

15. alert("Average performance");

16. }
17. else
18. {

19. alert("That's poor performance");

20. }
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing
Time: 120 min

Marks: 75

Question No: 1 (Marks: 1) - Please choose one

Navigation should remain

» Consistent
» Conflicting
» Contradictory

» Unpredictable

Question No: 2  (Marks: 1) - Please choose one

is a container that holds a value.

» |dentifier
» Variable
» Function

» Constant
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Question No: 3  (Marks: 1) - Please choose one

A variable can be in scope.

» Local
» Global
» Either local or global

» None of the given options

Question No: 4  (Marks: 1) - Please choose one

In a good presentation each slide should contain

» Heading

» Phrases not sentences

» Sentences not phrases

» Heading, sentences not phrases

Question No: 5  (Marks: 1) - Please choose one

The most upper right pixel of the screen is of color.

» Any
» Red
» Green

» Blue
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Question No: 6  (Marks: 1) - Please choose one

Which of the following data types are recognized by JavaScript?
» Strings
» Numbers
» Undefined

» All of the given options

Question No: 7  (Marks: 1) - Please choose one

Which of the following is NOT an Operating System?

» DOS
» Windows XP
» Linux

» Mainframe

Question No: 8  (Marks: 1) - Please choose one
WYSIWYG stands for
» What you say is what you get
What you say is what you get
» Where you see is where you go
» What you see is what you get

» When you see is when you ge
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Question No: 9  (Marks: 1) - Please choose one
are those programs in which the flow of the program is determined
by the user's actions (mouse clicks, key presses) or messages from other
programs.
» Event called programs
» Event processed programs

» Event driven programs

» Event declared programs

Question No: 10  (Marks: 1) - Please choose one

Programs that run on client machine and validate info that a user enters in a
form, are known as:

» Server-Side Scripts
» Client-Side Scripts
» Super Scripts

» Form Scripts

Question No: 11 (Marks: 1) - Please choose one

By default in a web page Hyper Link for another web page is represented as

» Blue only
» Black and Underlined
» Blue and Bold

» Blue and Underlined
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Question No: 12  (Marks: 1) - Please choose one

random () function returns a randomly-selected, floating-point number between

» 0and 1
» 0and 10
» 0 and-10

» 0and -1

Question No: 13  ( Marks: 1) - Please choose one

country="Hello Pakistan”;
document.write(country.length);

The output of the above statement is

> 12
> 13
> 14

» 15

Question No: 14  (Marks: 1) - Please choose one

The document.write( ) method expects as its argument.

» Integer
» Float
» String

» Boolean
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Question No: 15  (Marks: 1) - Please choose one

The political process is also influenced by the use of

» Discussion forums
» Newsgroups
» Mailing lists

» All of the given options

Question No: 16  (Marks: 1) - Please choose one

One of the key responsibilities of the is client relationship
management.

» Project Manager

» Team Lead

» Developer

» Quality Assurance Engineer

Question No: 17  (Marks: 1) - Please choose one

The group of technologies concerned with the capturing, processing and
transmission of information in the digital electronic form is called

» Telecom Engineering
» Computer Engineering
» Computer Science

» Information Technology
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Question No: 18  (Marks: 1) - Please choose one

The key responsibilities of the architect of the project is

» Technology selection
» High-level design
» Makes certain that the implementation remains true to the design

» All of the given options

Question No: 19  (Marks: 1) - Please choose one

has great PR skills.

» Architect
» Team Lead
» Project Manager

» Chief Executive Officer

Question No: 20  (Marks: 1) - Please choose one

Name, Border, Source are the of the image object.

» Event Handler
» Properties
» Methods

» None of the given options
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Question No: 21 (Marks: 1) - Please choose one

onAbort , onError are the of the image object.

» Event Handler
» Properties
» Methods

» None of the given options

Question No: 22  (Marks: 1) - Please choose one

Many developers write the first and then incrementally convert each
line into

» Real code & Pseudo code
» Pseudo code & Real code
» Real code & Atrtificial code
» None of the given options
Question No: 23  (Marks: 1) - Please choose one

Collection of facts & figures is called

» Information
» Data
» Entity

» Attribute
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Question No: 24  (Marks: 1) - Please choose one

is a related collection of WWW files that includes a beginning file
called a homepage

» HTML
» Website
» HTTP

» Web page

Question No: 25  (Marks: 1) - Please choose one

are the computers that perform at or near the currently highest
operational rate for computers.

» Minicomputers
» Microcomputers
» Supercomputers

» Personal Computers

Question No: 26  (Marks: 1) - Please choose one

Bit-mapped graphics is also known as graphics
» Vector
» Raster
» Scalar

» Simple
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Question No: 27  (Marks: 1) - Please choose one

Which event handler executes the specified JavaScript code when a
window/form element receives focus?

» onBlur
» onLoad
» onUnload

» onFocus

Question No: 28 ( Marks: 1) - Please choose one

Which function returns a randomly selected floating point number between 0 and
17?

» floor(x)
» ceil(x)
» random()

» round(x)

Question No: 29  (Marks: 1) - Please choose one
The Encryption of data is related to
» Data updates
» Data security
» Data integrity

» Data accessibility
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Question No: 30  (Marks: 1) - Please choose one

In JavaScript: In order to display the text on browser Grade A, which of
following statement is True.

» documentwrite( "Grade A")
» document.write( "Grade A");
» document.write( "Grade” && A");

» document.write( "Grade” && “A");

Question No: 31  (Marks: 1)

Does JavaScript provide any built-in method for image manipulation?

Question No: 32  (Marks: 1)

What are Local or Function-level Variables?
Question No: 33  (Marks: 2)

What is a function? Give one example.

Question No: 34  (Marks: 2)

What is the Data Normalization? Also define its goal.

Data normalization is to sort out complex data into simple form. It uses to
simplify the complex information to make it more user-friendly.

Question No: 35  (Marks: 3)
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What is the preferred organizational structure for the organization?

Preferred Organizational Structure for organization is hierarchal. Where there is
different departments interconnected with each other and are been divided
according to the functions they perform.

Question No: 36  (Marks: 3)

Differentiate Local and Global Variables.

Local variables are the variables have limited scope while global have bigger
scope

Local variables are not accessed by others while global is accessible to every
one

Local variable used by single user while global variable can be used by different
users at time from all around.

Question No: 37  (Marks: 3)
Elaborate Vector or Object oriented graphics with at least one example.

Object Oriented Graphics are the graphics which are generally oriented towards
the objects and have good quality to portray objects these graphics are object
oriented and use in animation, games and movies as well.

Question No: 38  (Marks: 5)

How DoS attack is a cyber crime? For what cyber crime can be used?

DoS stands for Decline of Service and it is a cyber crime as it jams and in some
cases shut down the targeted computer by sending too much unnecessary data
packets to it which ultimately exceeds the normal processing eventually results
the computer or server to stuck and unable to provide services to others. It can
be used to destroy the fame and diminishing of no of users requesting
information and services from that particular server or computer.
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Question No: 39  (Marks: 5)

Write HTML and JavaScript code that displays a textbox and button on a web
page. When user enters text in the text box and click the button it displays that
text in the message box.

Question No: 40  (Marks: 10)

Write code for the following screen shot. The text field should not accept any
other name except “CS101”. On wrong entry it should give you a message as
soon as you leave the text box.

!": Oy C51 shudenis sre slowesd b b she paper

—

Question No: 41  (Marks: 10)

Write a note on each of the following:

a. Vector or Object-Oriented Graphics:

b. Bit-Mapped or Raster Graphics:
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing (Session - 1)
Time: 120 min
Marks: 75

Question No: 1 (Marks: 1) -Please choose one
Vacuum tubes were replaced by _ » Transistors
» Punch cards
» Transistors
» Micro Processors
» Resistors

Question No: 2 (Marks: 1) -Please choose one
First electronic computer was » ABC

» ABC

» UNVAC 1

» Harvard Mark 1
» IBM PC

Question No: 3 (Marks: 1) -Please choose one
To improve the time for scannig a web page, text should be | 2
Centered

» Centered

» Left Aligned
» Right Aligned
» Staggered

Question No: 4 (Marks: 1) -Please choose one
JavaScript does not support_» Graphics

» User interaction

» Graphics

» Network operations

» Both Graphics and Network operations

Question No: 5 (Marks: 1) -Please choose one
» Identifier
is a container that holds a value.
» Identifier
» Variable
» Function
» Constant
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Question No: 6 (Marks: 1) -Please choose one
The default bullet for the list in HTML is» Circle shape
» Circle shape

» Disc shape
» Square shape

» Triangle shape

Question No: 7 (Marks: 1) -Please choose one
A single pixel can acquire approximately » 16 million
color schemes.
» 1 million
» 2 million
» 10 million
» 16 million

Question No: 8 (Marks: 1) -Please choose one
According to a popular heuristic, success is defined by _ » The user

» The user

» The builder

» Both user and builder

» None of the given options

Question No: 9 (Marks: 1) -Please choose one
Which one of the following is NOT a component of Rule Based System? Rule
Compiler

» Rule Compiler
» Rule Interpreter
» Rules Base

» Working Memory

Question No: 10 ( Marks: 1) -Please choose one
» Event processed programs are those programs in which the
flow of the program is determined by the user's actions (mouse clicks, key
presses) or messages from other programs.

» Event called programs

» Event processed programs

» Event driven programs

» Event declared programs
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Question No: 11  (Marks: 1) -Please choose one
The » Control unit
is connected to all other modules of the microprocessor.

» Control unit

» Memory unit

» Floating Point unit

» Arithmetic and Logic unit

Question No: 12 (Marks: 1) -Please choose one
Which of the followings is NOT a Relational DBMS software. » FrontPage

» Access

» FrontPage

» FileMaker Pro
» SQL Server

Question No: 13 (Marks: 1) -Please choose one
random() function returns a randomly-selected, floating-point number between
» 0and1

» 0and 1

» 0and 10

» 0and-10

» 0and -1

Question No: 14 (Marks: 1) -Please choose one
» Network

organization is replacing the old-style layered, tree-structured
organizational model.

» Network

» Hierarchical

» Matrix

» None of the given options

Question No: 15 (Marks: 1) -Please choose one
The _ »Typist is the old profession which is being eliminated
because of computing.
» Typist
> Bank manager
2 Operational manager
> All of the given options

Question No: 16 ( Marks: 1) -Please choose one
Distance learning has got a boost due to the »  All of the given options

> Easy communication
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> Online interactive contents
> Flexibility
> All of the given options

Question No: 17 (Marks: 1) -Please choose one
What is the 2nd step of DoS attack? » Search

> Race
> Arm

> Search
> Attack

Question No: 18 ( Marks: 1) -Please choose one

The _» Network paradigm

is becoming the preferred organizational structure for more and
more organizations with the passage of time.

> Tree structured organizational model

> Network paradigm

> Hierarchical structure

| 2 None of the given options

Question No: 19 (Marks: 1) -Please choose one
» TCP

routes the packets through the internet to go to their destination.

» Protocol
» TCP

> IP

» NIC

Question No: 20 (Marks: 1) -Please choose one
Many developers write the» Pseudo code first and then
incrementally convert each line into Real code

» Real code & Pseudo code

» Pseudo code & Real code

» Real code & Artificial code

» None of the given options
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Question No: 21 (Marks: 1) -Please choose one
Processed data is called _
» Information

» Information
» Data

» Entity

» Attribute

Question No: 22 (Marks: 1) -Please choose one
In a System having many parts to be designed, one should always do the _
» Simple part
__ first
» Hard part
» Simple part
» Development part
» Quality part

Question No: 23 (Marks: 1) -Please choose one
One can download or upload files to a remote computer using _ » TELNET
protocol.
» HTTP
» SMTP
» FTP
» TELNET

Question No: 24 (Marks: 1) -Please choose one
Which one is the example of spreadsheet software ? » MS Excel

» MS Word

» MS PowerPoint
» MS Excel

» MS Access

Question No: 25 (Marks: 1) -Please choose one
User can remotely log on to a computer and can have a control over it like a
local user using» TelNet Protocol and connected to the user through TCP/IP
network
» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP
» TCP/IP and FTP
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Question No: 26 ( Marks: 1) -Please choose one
Hardware malfunctions is related to » Data integrity

» Data updates

» Data integrity

» Data security

» Data accessibility

Question No: 27 (Marks: 1) -Please choose one
With the passage of time the field of Computing and Telecommunication is _
» Converging

» Diverging

» Converging

» Becoming different
» Becoming unique

Question No: 28 (Marks: 1) -Please choose one
Microphone is an input as well as output device. This statement is >
False

» True
» False

Question No: 29 (Marks: 1) -Please choose one
Application developers do not need to know much about the HW, especially the
microProcessor, while they are developing their application. » True

» True
» False

Question No: 30 (Marks: 1) -Please choose one
From which of the following is NOT a technique through which Security can be
improved : » Metal detectors

» Private or virtual-private networks

» Firewalls

» Metal detectors

» Virus detectors

Question No: 31 ( Marks: 1)
SMTP stands for what?
Ans: Simple Message transfer protocol

Question No: 32 ( Marks: 1)
In programming, what is an object ?
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Ans: An object is the collection of properties(date,state) ans methods
(instruction ,behavior)

Question No: 33 ( Marks: 2)
In which situation we should use Inline Event Handling?
Ans:Event handler are palced in the BODY portion of a web page as attributes of
HTML tages
The event handler attributes consist of 3 parts
a) The equal sign
b) The identifier of event handler
c) A string consisting of java script statements enclosed in double or
single string
Multiple javascript statements can be placed in that string ,but all have to fit in
a single line .
No new line characters with in line event handling

Inline event handler can be used normally in a condition when we want to
execute the eventd direclty and quickly in the same line of code.

Question No: 34 ( Marks: 2)

In JavaScript, what is event handling? What are the two types of events?

Ans: In JavaScript capturing of an events and responding to them is event
handling. The system sends events to the program and the program responds to
them as they arrive.

1. Events can include things a user does - like clicking the mouse.

2.  Events that the system itself does - like updating the clock.

Question No: 35 ( Marks: 3)
What is the preferred organizational structure for the organization?

Ans: Preferred Organizational Structure for organization is hierarchal. Where
there is different departments interconnected with each other and are been
divided according to the functions they perform.

1)Executive Team
2)
a)business development team
b )ArchitecutreTeam
c)technology Transfer team
3)
a) configuration Management Team
b)Process Team
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c)Quality assurance Team
d)Support team

4)
a) development Team A
b) development Team B
c) development Team C
d) development Team D

Question No: 36 ( Marks: 3)
What are the Sub categories of Artificial Intelligence? Briefly explain any two.
Ans

a)Neural networks: original inspiration was human brainemphasis now
usefulness as a computational tool

1) Genetic Algorithms : based on darwins evolutionary principle

GA requires the ability to recognize a good solution but not

howto get to that solution

2) rulebased systems
b) the right techniques

Question No: 37 ( Marks: 3)
Diffentiate Local and Global Variables.
Ans:

Local Variables:

When a function is define the variable use for storing values are
incorporated inside the function these variable are found and used only inside
these function are called local variable .these have no presence out side the
function
Global Variables :Global variable on other hand are present through out the
script and their values can be access by any function .They global scope

Question No: 38 (Marks: 5)
Write the JavaScript code for the Function SumOddNumbers(maxNumber) that
can add non-negative odd numbers up to maxNumber and return their sum.

Question No: 39 (Marks: 5)

What is animated gif? How can we use it? If we animate images in JavaScript
then is it better?

Ans: It is bit mape image format introduced in 1987by compuserve.It support up
to 8 bits per pixel.lt also support animation And allow a separate palette of 256
colors for each frame.

Uses:We can use it in web site they are suitable for sharp edged line art with
limited number of colors.They are good for small animation and low resolution
clips.

The size is small and on web site they can uploaded and downloaded easily
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Question No: 40 ( Marks: 10)
What is the problem with Relational Database and what solution you can
suggest for it?
Ans:
when we use to store object oriented data into a Relational database

it need to be translated in form which is suitable for the relational database.
Again when we need to read RDBMs the Data need again back to be translated
into object oriented form to read.
This two process delay associated processing and time spent in writing and
maintaining the translation codes are the key disadvantage with Relational
Database .
Solution:

Object oriented database

Object Relational database

The data should be divided and save in multiple table and tabular form ,so that
open ,searching .sorting ,editing and saving of data can be performed quickly.
With tabular form one can sort w.r

Question No: 41 ( Marks: 10)

How can we neutralize DoS attack? Can we track the attacker?

Ans: Denial of service attempt to make a computer resource unavailable to its
Intended user . Easiest way to survive an attack is to have planned for the attack.
Good contact with ISP and some security providers and CERT are essential also
having a separate emergency block of IP address for Critical servers with a
separate rout can be effective.

We should use genuine operating system can also be helpful.

By using an extremely stateful packet filter that will inexpensively drop any
unwanted packet serviving DoS attack Becomes much Easier.

We can also use Fierwalls .

Using Antivirus softwear

Using private net work

Using encryption

Network Sniffer

Intrusion detector By using all these techniques we can neutralize DoS Attack

Investigative process should begin immediately after the DoS Attack begins.
By using IP address we can Track Attacker.
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing (Session - 2)
Time: 120 min
Marks: 75

Question No: 1 (Marks: 1) -Please choose one
The memory size of the Altair 8800 was

» 128 bytes

» 128 Kilo bytes

» 256 Kilo bytes

> 256 bytes

Question No: 2 (Marks: 1) -Please choose one

A named collection of properties (data, state) and methods (instruction,

behavior) is called
» Array
» Function
» Variable
» Object

Question No: 3 (Marks: 1) -Please choose one
JavaScript Variables are
» Dynamically Typed
» Statically Typed
» Strong Typed
» None of the given options

Question No: 4 (Marks: 1) -Please choose one
Serial arrangement in which things follow logical order or a recurrent pattern,
such as statements executing one by one, is called

» Loop

» Sequence

» Condition

» Array

Question No: 5 (Marks: 1) -Please choose one
Rule of thumb learned through trial and error is called
» Design
» Heuristic
» Plan
» Aim
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Question No: 6 (Marks: 1) -Please choose one
According to heuristic, if you can’t explain it in minutes, either
you don’t understand it or it does not work.

» 10

> 2

> 5

> 4

Question No: 7 (Marks: 1) -Please choose one
To store rounded number of 8.6 in a variable called "r_number", we write

» r_numbers=Maths.rounds(8.6)
» r_number=Math.rounds(8.6)
» r_number=Math.round(8.6)
» r_number=Maths.round(8.6)

Question No: 8 (Marks: 1) -Please choose one
Using only HTML we can create

» Dynamic web pages
» Static web pages
» Both Static and Dynamic pages

» None of these

Question No: 9 (Marks: 1) -Please choose one
function returns the largest integer that is less than or equal to x.
» round(x)
» floor
» ceil
» abs(x)

Question No: 10 ( Marks: 1) -Please choose one
Due to working at home, contact with the colleagues is , which may
resultin quality of work

» Reduced, Poorer

» Reduced, Better

» Increased, Poorer

» Increased, Better
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Question No: 11  (Marks: 1) -Please choose one
The distance among families is because of spending more time
on internet.

» Increased

» Expanded

» Contracted

» Decreased

Question No: 12 (Marks: 1) -Please choose one
When web server is busy it gives the following message to the user :
» Time out
» Waiting
» Server busy
» None of the given options

Question No: 13 (Marks: 1) -Please choose one

is designed for detecting viruses and inoculating.
» Antivirus

» Ultility

» Trojan

» None of the given choices

Question No: 14 (Marks: 1) -Please choose one
The is becoming the preferred organizational structure for more
and more organizations with the passage of time.

» Tree structured organizational model

» Network paradigm

» Hierarchical structure

» None of the given options

Question No: 15 (Marks: 1) -Please choose one
Planning and tracking of the project is the responsibility of the
» Project Manager
» Architect
» Developer
» Chief Executive Officer

Question No: 16 ( Marks: 1) -Please choose one
The responsibilities of the Team Lead includes
» Planning and tracking of the project
» Detailed design
» Professional development of team members
» All of the given options
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Question No: 17 (Marks: 1) -Please choose one
team is responsible for a project after the specification’s stage

till the very end.
» Executive
» Architect
» Development
» HR

Question No: 18 ( Marks: 1) -Please choose one
There are types of errors.

> 2

> 3

> 4

> 5

Question No: 19 (Marks: 1) -Please choose one
are the computers that perform at or near the currently highest
operational rate for computers.
» Minicomputers
» Microcomputers
» Supercomputers
» Personal Computers

Question No: 20 (Marks: 1) -Please choose one
Which one of these is NOT an example of storage devices?
» Tape
» RAM
» Floppy
» DVD

Question No: 21 (Marks: 1) -Please choose one
Forms can be submitted by using different methods
> 2
> 3
> 4
» 5

Question No: 22 (Marks: 1) -Please choose one
Which is NOT true for JavaScript variable name ?

» Student

» Roll_no_1111

» For

» schedule

Question No: 23 (Marks: 1) -Please choose one
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One can browse documents residing on a remote computer using
protocol.

» HTTP

» SMTP

» FTP

» TELNET

Question No: 24 (Marks: 1) -Please choose one
Which one is the example of spreadsheet software ?

» MS Word

» MS PowerPoint

» MS Excel

» MS Access

Question No: 25 (Marks: 1) -Please choose one
User can remotely log on to a computer and can have a control over it like a
local user using
» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP
» TCP/IP and FTP

Question No: 26 ( Marks: 1) -Please choose one
Hardware malfunctions is related to

» Data updates

» Data integrity

» Data security

» Data accessibility

Question No: 27 (Marks: 1) -Please choose one
PowerBuilder falls in the category of

» Assembly Languages

» 4-th Generation Languages
» Machine Languages

» High-Level Languages

Question No: 28 (Marks: 1) -Please choose one
Backbone is also called as

» vBNS

» BNS

» VHBNS

» HBNS
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Question No: 29 (Marks: 1) -Please choose one
Global variables can make the logic of a web page.

» Difficult to understand

» Easier to understand and maintain

» Difficult to reuse and maintain

» Difficult to understand, reuse and maintain

Question No: 30 (Marks: 1) -Please choose one
In JavaScript: In order to display the text on browser Grade A, which of following
statement is True.

» documentwrite( "Grade A")

» document.write( "Grade A");

» document.write( "Grade” && A");
» document.write( "Grade” && “A");

Question No: 31 ( Marks: 1)
What is bandwidth?
Bandwidth is a capacity of communication channel of carrying data.

Question No: 32 ( Marks: 1)
What is “My Personal Agent”?
A computer programe that work automatically and have voice interface

Question No: 33 ( Marks: 2)
For what purposes FTP is used in networks ?
To download or upload files / data to a remote computer

Question No: 34 ( Marks: 2)
How can you define a readable program?
A program that is easy to read & understand also easy to maintain and enhance.

Question No: 35 ( Marks: 3)
What is the preferred organizational structure for the organization?
The Network Organization: It is becoming the preferred organizational structure.

Question No: 36 ( Marks: 3)

How can you define a consistent web design? Why is it needed?

A consistent web design is Easy understandable, not with heavy graphics, easy
navigation. It is needed because most of the website views leave the site
because of poor navigation and not easy to understand, text and design is not
clear etc.

Question No: 37 ( Marks: 3)
Elaborate Vector or Object oriented graphics with atleast one example.
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Vector treats everything that is drawn as object, they are resolution in dependent
and relatively small file size. For example swg, svg, wmf.

Question No: 38 ( Marks: 5)
What are the advantages of multimedia presentations? Write any five.
Multimedia presentation is a great tool for effective communication:

Advantages:

Easy to make last minute change

More attractive

Can include animation, videos etc.

Better presentation easy to understandable for participants comparing to manual
presentation.

5. Undo feature

PN~

Question No: 39 (Marks: 5)

Can a human doctor be replaced by an Expert System? Give reasons to support
your answer.

Expert System is a computer system which simulates the knowledge and
expertise of a human expert. Yes, a human doctor can be replaced by an Expert

System. Following are the reasons to support my answer:
1. Alarge database of knowledge can be added to and kept up to date, it can store more
knowledge than a person.
2. The Expert System cannot FORGET or get facts wrong.
3. It survives forever. There is no loss of knowledge as there is when a doctor retires.
4. The Expert System can access specialist knowledge that a doctor may not have.

Question No: 40 ( Marks: 10)
Explain the following issues of Data Management? (3+4+3)

1. Data entry

2. Data updates
3. Data security
DATA ENTRY:

There is new data entered every day.

New customers are added every day.

Some of the data entry requires the manual entry into computer system
New data entry needs to be entered correctly

DATA UPDATES:

Old titles must be removed regularly
Data changes every time

Prices change

Transportation / shipping cost changes
Customer personal data changes
Schemes changing, new offers
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Every new entry needs to be entered correctly

DATA SECURITY:

All data in the system is very critical to its operation, the security of the
customer’s personal data is most important. Most of the hackers are always
trying for that type of information specially Credit Card Numbers.

This problem can be managed by using proper security arrangements and
mechanisms that provides access to only authorized entities. System Security
can be improved through, encryption, firewalls and updated Antivirus Softwares

Question No: 41 ( Marks: 10)
Write a note on the followings

a. Image Preloading process
b.  Animated Gifs

IMAGE PRELOADING PROCESS:

The primary use of image preloading process is to download the image into the
cache before it is actually needed to display.

PROCESS:

1. An example of the image object is shaped using the NEW keyword
2. The src property of this instance is set equal to the filename of the
image to be pre-loaded

3. This step starts the down-loading of the image into the cache
without actually displaying

4. When a pre-loaded image is required to be displayed, the src

property of the displayed image is set to the src property of pre fetched image

ANIMATE GIFS:

We can save 16 gif images of the previous example in a single file in the form of
an animated gif, and then used it in a regular <IMG> tag to display a moving
image. However, JavaScript provide better control over the sequencing and the
gap between the individual images.
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing (Session - 4)

Question No: 1 (Marks: 1) -Please choose one
Success of a website is defined by .
> User correct is user
> Designer X
» Developer
» Programmer

Question No: 2 (Marks: 1) -Please choose one
Which one is correct for JavaScript?

> onMouseOver
» OnMouseOver
» onmouseover
» All of the given

Question No: 3 (Marks: 1) -Please choose one
An indexed list of elements is called

» Collection

> Array
» Set

» Group

Question No: 4 (Marks: 1) -Please choose one
is the way that internet domain names are located and translated into
IP addresses.
» FTP
» VolP
> DNS
» TCP

Question No: 5 (Marks: 1) -Please choose one
The browser breaks down the URL into parts.
> 2
> 3
> 4
> 5
Question No: 6 (Marks: 1) -Please choose one
Which one of the following is not an event handler's attribute?
» Function
» |dentifier
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» Equal sign
» String consisting of JavaScript statements

Question No: 7 (Marks: 1) -Please choose one
JavaScript Variables are .

> Dynamically Type

» Statically Typed

» Strong Typed

» None of the given options

Question No: 8 (Marks: 1) -Please choose one
Which of the following is NOT a Loop statement?

» For

» While

> Switch

» Do-While

Question No: 9 (Marks: 1) -Please choose one
According to a popular heuristic, success is defined by

> The user

» The builder

» Both user and builder

» None of the given options

Question No: 10 ( Marks: 1) -Please choose one
Which one of the following is an application for artificial intelligence?
> Robotic
» Web Agent
» Decision Support System
» All of the given options

Question No: 11  ( Marks: 1) - Please choose one
Using only HTML we can create

» Dynamic web pages

» Static web pages

» Both Static and Dynamic pages

» None of these
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Question No: 12 (Marks: 1) -Please choose one
The is connected to all other modules of the microprocessor.

> Control unit

» Memory unit

» Floating Point unit

> Arithmetic and Logic unit

Question No: 13 (Marks: 1) -Please choose one
Which of the followings is NOT a Relational DBMS software.
» Access
» FrontPage
» FileMaker Pro
> SQL Server
Question No: 14 (Marks: 1) -Please choose one
country="Hello Pakistan”;
document.write(country.length);

The out put of the above statement is
> 12
» 13
> 14
> 15

Question No: 15 (Marks: 1) -Please choose one
The distance among families is because of spending more time
on internet.

> Increased

» Expanded

» Contracted

» Decreased

Question No: 16 ( Marks: 1) -Please choose one

is a field that uniquely identifies each record stored in a table.
» Composite Key

> Primary key

» Foreign key

» None of the given options

Question No: 17 (Marks: 1) -Please choose one
Planning and tracking of the project is the responsibility of the
» Architect
> Team Lead
» Developer
» Chief Executive Officer
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Question No: 18 ( Marks: 1) -Please choose one
has great PR skKills.

» Architect

» Team Lead

> Project Manager

> Chief Executive Officer

Question No: 19 (Marks: 1) -Please choose one
team is responsible for a project after the specification’s stage

till the very end.

> Executive

» Architect

> Development
» HR

Question No: 20 (Marks: 1) -Please choose one
A large number of networks interconnected physically is called
» LAN
> MAN
> Internet
» Network collection

Question No: 21 (Marks: 1) -Please choose one

Efficiency is to universality
» Equal
> Direct proportional

» Inversely proportional
» Not proportional

Question No: 22 (Marks: 1) -Please choose one

There are ways of calling functions.
» One
> Two
» Three
» Four

Question No: 23 (Marks: 1) -Please choose one
Which protocol is use to transfer a file over the network ?
» UDP
> FTP
» TCP
» OSI

Question No: 24 (Marks: 1) -Please choose one
Writing a response, multiple statements are separated from each other with the
help of

> Period (.)
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» Comma (,)
» Colon (:)
» Semicolon ( ;)

Question No: 25 (Marks: 1) -Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping
» RGB and Dithering
» RGB, Color mapping and Dithering
> Color mapping and Dithering

Question No: 26 ( Marks: 1) -Please choose one
has the ability to automate and simplify daily tasks.

» Productivity software

> Application software

» System software
» Graphical software
Question No: 27 (Marks: 1) -Please choose one

Which representation technique of algorithm is more suitable for developer to
make actual code

» pseudo code
» flow chart

» both pseudo code and flow chart

» Heuristics

Question No: 28 (Marks: 1) -Please choose one
is used to terminate all JavaScript statements.

» Colon

> Semicolon
» Underscore

» Apostrophe
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Question No: 29 (Marks: 1) -Please choose one

CONCATENATE operator is used to elements.
» Subtract
» Multiply
> Join
» Add

Question No: 30 (Marks: 1) -Please choose one
In partitioning of program/module, it should be assured that partitioned

chunks should be as as possible.
» Dependent
> Independent
» Complex

» All of the above

Question No: 31 ( Marks: 1)

What is the out put of the following JavaScript code ?
name="Ali Akbar”;
document.write(name.charAt(4)) ;

Ans. A

Question No: 32 ( Marks: 1)
What does WAN stand for?

Wide Area Network — A network in which computers are separated by great
distances typically across cities or even continents.

Question No: 33 ( Marks: 2)
Why hub is used in networks?

The network traffic controller — components of convential computer networks.
Hub is used to connect the different computers in the network i.e. to the server.

Question No: 34 ( Marks: 2)
What is output of the following JavaScript code ?
Str="Virtual University of Pakistan”;
document.write(str.substring(5,str.length)) ;

Question No: 35 ( Marks: 3)
Explain how many ways businesses monitor their employees?

Systems are available that monitor or most every key stroke that an employee
makes on computer. Systems are available that read and sensor all incoming

http://vustudents.ning.com 169




and outgoing email. It is quite straight forward to monitor where you surf and
when.

Question No: 36 ( Marks: 3)
Diffentiate Local and Global Variables.

Local or function level variable effective only in the function in which they are
declared while globale variables visible everywhere on the webpage. Declaration
variables using the var keyword within a function makes them local. They are
available only within the function and hold no meaning outside of vs global.

Question No: 37 ( Marks: 3)
Elaborate Vector or Object oriented graphics with atleast one example.

Treats everything that is drawn an object. Objects retain their identity after their
drawn. These objects can later be easily moved stretched duplicated deleted etc
are resolution independent relatively small size. e. g. swf, wmf,

Question No: 38 (Marks: 5)
Show output of the following code:

for (i=0; i<=10; i++)

{

document.write("The number is " + i);
document.write("<br />");

}

The numberis 0
The number is 1
The number is 2
The number is 3
The number is 4
The number is 5
The number is 6
The numberis 7
The number is 8
The number is 9
The number is 10
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Question No: 39 ( Marks: 5)
Why should we, as computing professionals, be interested in studying the social
implications of our creations?

This is imp. Because of keeping the track of money wise while implementation
actually and see the results. This fits with the organization or no. to check there is

any side effects morally or no. we have to be very careful while creation of any
system., error free, data loose recovery. Etc.

Question No: 40 ( Marks: 10)
Write responsibilities of the followings
1. Developer

a) Module level design.

b) Coding
c) Unit testing

2. Executive Team

a) Responsible for the day to day operations.
b) All the decision related issues.

c) Policy making and changing etc.

e.g. In this usually CEO and CMSO involves

1. He is responsible for the day to day operation and great organizational skills.

3. Support Team

The support team is responsible for the complete operations such as
arrangement for performing any kind of task from the starts to the end. Fully
project handling and performing etc. In case of any maintenance they are the
responsible for commencing the job and making sure to complete.
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Question No: 41 ( Marks: 10)

Write HTML and JavaScript code for the requirements shown in the diagram
below.

When ConvertoUpperCase button is pressed, the entered text is converted to
upper case and result is displayed in the result text box. Similarly, when
ConvertoLowerCase button is pressed, the entered text is converted to lower
case and result is displayed in the result text box.

l—nﬁ’ Gl | @8 Changecase W
ChangeCase Example
Enter a lowercase string |___Converto Uppercase |
E" Enter an uppercase sting [__Convertto Lowsrcase |
Result
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FINALTERM EXAMINATION
Fall 2009

CS101- Introduction to Computing (Session - 1)

Time: 120 min
Marks: 75
Question No: 1 (Marks: 1) -Please choose one
Website design should NOT be
» Unified
» Complex
» Consistent

» Predictable

Question No: 2 (Marks: 1) -Please choose one
Navigation should remain

» Consistent

» Conflicting

» Contradictory

» Unpredictable

Question No: 3 (Marks: 1) -Please choose one

is a program that executes instructions line by line written in a high-
level language.
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» Interpreter
» Compiler
» Predictor

» Executor

Question No: 4 (Marks: 1) -Please choose one

Detailed plan, specifying the required resources and expected deliverables, is
done in phase.

» Planning
» User Requirements
» Design

» Developer Specification

Question No: 5 (Marks: 1) -Please choose one

A single pixel can acquire approximately color schemes.

» 1 million
» 2 million
» 10 million
» 16 million
Question No: 6 (Marks: 1) -Please choose one
Which of the following data types are recognized by JavaScript?
» Strings

» Numbers
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» Undefined

» All of the given options

Question No: 7 (Marks: 1) -Please choose one

According to heuristic, if you can’t explain it in minutes, either
you don’t understand it or it does not work.

> 10
> 2
> 5

> 4

Question No: 8 (Marks: 1) -Please choose one

The idea of Neural Networks field is based upon

» Human nature
» Human brain
» Human culture

» Human actions

Question No: 9 (Marks: 1) -Please choose one

Fuzzy logic is based on

» Ground facts
» Experience
» Practice

» Approximation
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Question No: 10 ( Marks: 1) -Please choose one

a = Math.ceil(12.01)

What will be the value of a ?

> 12
> 13
> 12.0

> 13.01

Question No: 11 (Marks: 1) -Please choose one
Which of the followings is NOT a Relational DBMS software.
» Access
» FrontPage
» FileMaker Pro

» SQL Server

Question No: 12 (Marks: 1) -Please choose one

Due to working at home, contact with the colleagues is , which may
result in quality of work

» Reduced, Poorer
» Reduced, Better
» Increased, Poorer

» Increased, Better
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Question No: 13 (Marks: 1) -Please choose one

When web server is busy it gives the following message to the user :

» Time out
» Waiting
» Server busy

» None of the given options

Question No: 14 (Marks: 1) -Please choose one
Trinoo is a software.

» DoS

» Scanning

» Utility

» None of the given options

Question No: 15 (Marks: 1) -Please choose one

We use to stop Break-Ins.

» Scanners

» Intrusion detectors

» Utilities

» None of the given options

Question No: 16 (Marks: 1) -Please choose one

Spies of one business monitoring the network traffic of their competitors’

» Industrial Intelligence
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» Industrial Espionage
» Industrial Spying

» Industrial Surveillance

Question No: 17 (Marks: 1) -Please choose one

One of the key responsibilities of the is client relationship
management.

» Project Manager
» Team Lead
» Developer

» Quality Assurance Engineer

Question No: 18 (Marks: 1) -Please choose one
There are types of errors.

> 2

> 3

> 4

» 5

Question No: 19 (Marks: 1) -Please choose one

The important attribute of image tag is

» src
» image
» None of the given options
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» alt

Question No: 20 (Marks: 1) -Please choose one

Name, Border , Source are the of the image object.

» Event Handler
» Properties
» Methods

» None of the given options

Question No: 21 (Marks: 1) -Please choose one

breaks down the message, to be sent over the internet, into

packets.
» Protocol
» TCP
> IP

» NIC

Question No: 22 (Marks: 1) -Please choose one

is a client program that uses HTTP to make requests to Web servers
throughout the internet on behalf of the user.

» Web Application
» Web Browser
» Internet Application

» HTML
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Question No: 23 (Marks: 1) -Please choose one

We can change the background color in HTML, using ____ attribute of <body>

» background
» bgcolor
» backcolor

» backgroundcolor

Question No: 24 (Marks: 1) -Please choose one

Application developers do not need to know much about the while
they are developing their applications

» Software
» Hardware
» Operating System

» Kernel

Question No: 25 (Marks: 1) -Please choose one

After computer is turned ON, the Loader loads into the memory.
» Hardware
» Device Manager
» File Manager

» Kernel

Question No: 26 ( Marks: 1) -Please choose one
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Users look for solution.
» Optimal
» First good enough
» Good

» Best

Question No: 27 (Marks: 1) -Please choose one
Hardware malfunctions is related to

» Data updates

» Data integrity

» Data security

» Data accessibility

Question No: 28 (Marks: 1) -Please choose one

JavaScript function fixed() has equivalent HTML tag-set

> <FIX>............. </FIX>
> <F>. </F>

» <PRE>............. </PRE>
> <H> ... </H>

Question No: 29 (Marks: 1) -Please choose one

What is the key feature of computer which is against human nature?
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» Can’t get bored.
» Pattern recognition
» Repetition

» None

Question No: 30 (Marks: 1) -Please choose one

means to break down into simpler components and analyze.

» Recursion

» Parsing

» Scope

» Navigation
Question No: 31 ( Marks: 1)
SMTP stands for what?

Simple Mail Transfer Protocol

Question No: 32 ( Marks: 1)
How can we stop mail bombing attack ?

By Email Filtering

Question No: 33 ( Marks: 2)

For what purposes FTP is used in networks ?

We can download or upload files to remote computers on a TCP/IP Network
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Question No: 34 ( Marks: 2)
How can you define a readable program?

A program which is easy to read and understand and easy to maintain and
enhance.

Question No: 35 ( Marks: 3)
What is the preferred organizational structure for the organization?

The network paradigm is the preferred organizational plan which is replaced
by old layered, tree structured organizational model. People think that business
can be done in more effective manner if more emphasis on cooperation, shared
responsibility and networking within the organization and also outside the
organization. The structure of the networked organization is flexible and
changeable according to the requirements of the usere It shares knowledge and
decentralizes the control of the operation so that network works effectively and
business may achieve goals of the organization

Question No: 36 ( Marks: 3)
Differentiate between LAN and WAN with one example of each.

LAN(local Area network) A network within a same building or some nearly
located buildings. Example is Network of a university or college.

WAN (Wide Area Network) A network which is scattered in a very big area

even to the other cities or countries. It may consist of many LANs also. Internet is
the best example of WAN.

Question No: 37 ( Marks: 3)
Differentiate between onLoad and onUnload

onLoad executes the specified JavaScript code when a new document is
loaded into a window.

onUnload executes the specified JavaScript code when a user exits a
document.
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Question No: 38 ( Marks: 5)
Mention any five applications of Artificial Intelligent System.

Medical Diagnosis
Robots

Games

Business Intelligence
Image Recognition

abrowd =

Question No: 39 (Marks: 5)
Explain function arguments with the help of an example?

Function is a group of statements which is defined once in a web page and
can be used repeatedly. It is also known as procedure, subprograms and
subroutine. By using functions codes becomes easier to understand and number
of lines are also reduced. It is easy to maintain a function because we make a
single change in a function and it reflects on multiple locations.

It is a comma separated list of data. It defines interface between the web page
and the function. Arguments values are passed to the function by value or by
reference. It should be defined in the HEAD portion of Web pages before called

up.
Example:

Function add( a, b ) {

c=a+b;
return c ;
}

sum=add(2,4);

document. write( sum ) ;
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Question No: 40 ( Marks: 10)
What is Data Integrity? How can we ensure it (any three ways) ? (4+6)

Data integrity is the maintaining, consistency and correctness of the data.
Consistency means there should be no conflict between data items and
correctness is the freedom of error. It means there should be no error in the
given data. Data should be interrelated also and easy to access the required
data.

There are many ways to integrate data.
1. Limit Integrity: By limiting the values of data items to specified ranges to

prevent illegal values. Age of person should not be negative is the best
example.

1. Type Integrity is enforced by specifying the type of a data item. Using
credit cards we need to enter exactly 12 digits. More are less are not
allowed.

1. Referential Integrity is implemented by an item referenced by the data for
some other item and it must exist in the database. Reservation of a flight
is the example.

Question No: 41 ( Marks: 10)

Define network organization? What are important features of network
organization? (4+6)
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FINALTERM EXAMINATION
Fall 2009

CS101- Introduction to Computing

Time: 120 min

Marks: 75

Question No: 1 ( Marks: 1) - Please choose one

Charles Babbage was a/an

» Mathematician
» Computer Scientist
» Physician

» Analyst

Question No: 2  ( Marks: 1) - Please choose one
A variable can be in scope.
» Local
» Global
» Either local or global

» None of the given options
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Question No: 3  ( Marks: 1) - Please choose one

A is a meaningful, easy-to-remember ‘label’ for an |IP address.
» TCP address
» Domain name
» Network name

» VolP

Question No: 4  ( Marks: 1) - Please choose one

Which one is NOT a presentation software?

» MS Access
» CA Harvard Graphics
» Corel Presentation

» Lotus Freelance

Question No: 5 ( Marks: 1) - Please choose one

Capturing events and responding to them is called

» Function Handling
» Event Handling
» Event Procedure

» All of the given option
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Question No: 6  ( Marks: 1) - Please choose one

Rule of thumb learned through trial and error is called

» Design
» Heuristic
» Plan

» Aim

Question No: 7  ( Marks: 1) - Please choose one

In the old days, databases did NOT support

» Number
» Boolean
» Video

» Text

Question No: 8 ( Marks: 1) - Please choose one

The __ is connected to all other modules of the microprocessor.
» Control unit
» Memory unit
» Floating Point unit

» Arithmetic and Logic unit

http://vustudents.ning.com 188




Question No: 9  ( Marks: 1) - Please choose one

In tabular storage, fields placed in a particular row are strongly

» Independent
» Dependent
» Interrelated
» Inconsistent

Question No: 10  ( Marks: 1) - Please choose one

function returns the largest integer that is less than or equal to x.
» round(x)
» floor
» ceil

» abs(x)

Question No: 11 ( Marks: 1) - Please choose one

Due to working at home, contact with the colleagues is , which may
result in quality of work

» Reduced, Poorer
» Reduced, Better
» Increased, Poorer

» Increased, Better
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Question No: 12  ( Marks: 1) - Please choose one

Tribal flood network is a software.

» DoS
» Scanning
» Utility

» None of the given options

Question No: 13  ( Marks: 1) - Please choose one

A stream of large sized emails are sent to an email address for overloading the
destination account, is called

» DoS Attack
» Break-Ins
» Mail Bombing

» All of the given options

Question No: 14  ( Marks: 1) - Please choose one
To stop industrial espionage, we use
» Private network
» Encryption
» Network sniffer

» All of the given options
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Question No: 15  ( Marks: 1) - Please choose one

Unlike virus, is a stand-alone program.

» Trojan horse
» Logic bomb
» Worm

» Time bomb

Question No: 16  ( Marks: 1) - Please choose one

Smart editors can automatically color different parts of statements in different
colors e.g. comments in color.

» Green
» Grey
» Blue

» Red

Question No: 17  ( Marks: 1) - Please choose one

onAbort , onError are the of the image object.

» Event Handler

» Properties
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» Methods

» None of the given options

Question No: 18  ( Marks: 1) - Please choose one

Quantum Mechanics is the branch of ; which describes the activity of
subatomic particles

» Chemistry
» Computer Science
» Physics

» Biology

Question No: 19  ( Marks: 1) - Please choose one

Communication protocol is a that governs the flow of information
over a network

» Set of protocols
» Set of rules
» Device

» Set of methods

Question No: 20 ( Marks: 1) - Please choose one

Web is a unique invention by humans in terms that it is:

» accessible to only the owners who control it

http://vustudents.ning.com 192




» accessible from particular locations only
» accessible to all humans

» accessible to only the educational institutes

Question No: 21 ( Marks: 1) - Please choose one

is the example of server-side scripts on Unix servers.

» ASP
» CGI
» VBScript

» JavaScript

Question No: 22  ( Marks: 1) - Please choose one

Which is NOT true for JavaScript variable name ?
» Student
» Roll no 1111
» For

» schedule
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Question No: 23  ( Marks: 1) - Please choose one

User can remotely log on to a computer and can have a control over it like a local
user using

» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP

» TCP/IP and FTP

Question No: 24  ( Marks: 1) - Please choose one

Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping
» RGB and Dithering
» RGB, Color mapping and Dithering

» Color mapping and Dithering
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Question No: 25 ( Marks: 1) - Please choose one

Which function returns a randomly selected floating point number between 0 and
17?

» floor(x)
» ceil(x)
» random()

» round(x)

Question No: 26  ( Marks: 1) - Please choose one

In flat-file databases each record was separated by a special character named :

» Horizontal bar
» Vertical bar
» Text bar
» Character bar
Question No: 27  ( Marks: 1) - Please choose one

With the passage of time the field of Computing and Telecommunication is

» Diverging
» Converging
» Becoming different

» Becoming unique
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Question No: 28  ( Marks: 1) - Please choose one
Which of the following is NOT true about modern computers?
» More powerful
» Smaller in size
» Consume less energy

» Costly

Question No: 29  ( Marks: 1) - Please choose one

Mathematical functions in JavaScript, are accessed by referring to various
methods of the object.

» Math
» Calculate
» Compute

» None of the given options

Question No: 30  ( Marks: 1) - Please choose one

An algorithm that always takes the best immediate or local solution while finding
an answer is called

» Deterministic Algorithm
» Non deterministic Algorithm
» Greedy Algorithm

» Randomized Algorithm
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Question No: 31  ( Marks: 1)

SMTP stands for what?

Question No: 32  ( Marks: 1)

What are the types of computer network according to the distance between
nodes?

Question No: 33  ( Marks: 2)

What is the Data Normalization? Also define its goal.

Question No: 34  ( Marks: 2)

What is the use of Default keyword in switch structure?

Question No: 35 ( Marks: 3)

What is the difference between Internet and Intranet ?

Question No: 36  ( Marks: 3)

Write down three advantages of using Functions in a program.
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Question No: 37  ( Marks: 3)

What are Trojan Horses ?
Question No: 38 (Marks: 5)
In which situation, we use:

i- switch construct

ii- multiple If-else construct

Question No: 39  (Marks: 5)

List any five issues of Data Management.

Question No: 40  ( Marks: 10)

How can you make your website's structure more navigable?

Question No: 41  ( Marks: 10)

Define network organization? What are important features of network
organization? (4+6)
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FINALTERM EXAMINATION
Fall 2009
CS101- Introduction to Computing (Session - 2)
Time: 120 min
Marks: 75
Question No:1 (Marks: 1) -Please choose one
Most frequently used computers are:
» Mainframe Computers
» Personal Computers
» Supper Computers

» Embedded Computers

Question No: 2 (Marks: 1) -Please choose one

Success of a website is defined by

» User
» Designer
» Developer

» Programmer

Question No: 3 (Marks: 1) -Please choose one

breaks down the message to be sent over the internet into packets.

> FTP
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» HTTP
» TCP

> IP

Question No: 4 (Marks: 1) -Please choose one

JavaScript does not support

» User interaction
» Graphics
» Network operations

» Both Graphics and Network operations

Question No: 5 (Marks: 1) -Please choose one

Detailed plan, specifying the required resources and expected deliverables, is
done in phase.

» Planning
» User Requirements
» Design

» Developer Specification

Question No: 6 (Marks: 1) -Please choose one

In a good presentation each slide should contain

» Heading

» Phrases not sentences

http://vustudents.ning.com 200




» Sentences not phrases

» Heading, sentences not phrases

Question No: 7 (Marks: 1) -Please choose one
Which one of the following is NOT a primary color?

» Red

» Green

» Yellow

» Blue

Question No: 8 (Marks: 1) -Please choose one

Spread sheet is a type of

» Productivity software

» Engineering software

» Mathematical software

» Business software

Question No: 9 (Marks: 1) -Please choose one

When'+’ operator is used with string operands, it both strings.

» Adds
» Subtracts

» Concatenates
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» Compares

Question No: 10 ( Marks: 1) -Please choose one

When web server is busy it gives the following message to the user :
» Time out
» Waiting
» Server busy

» None of the given options

Question No: 11 (Marks: 1) -Please choose one

Which attribute of the IMG tag tells us about the source of the image

» source
» path
» loc

» src

Question No: 12 ( Marks: 1) -Please choose one

The is becoming the preferred organizational structure for more
and more organizations with the passage of time.

» Tree structured organizational model
» Network paradigm
» Hierarchical structure

» None of the given options

http://vustudents.ning.com 202




Question No: 13 (Marks: 1) -Please choose one

The Information technology has three components

» Telecom Engineering, Network Engineering, Computer Science
» Telecom Engineering, Computer Engineering, Computer Science
» Telecom Engineering, Computer Engineering, Database Engineering

» Telecom Engineering, Computer Engineering, Hardware Engineering

Question No: 14 (Marks: 1) -Please choose one

has great PR skills.

» Architect
» Team Lead
» Project Manager

» Chief Executive Officer

Question No: 15 (Marks: 1) -Please choose one

errors are caused by the code that somehow violates the rule of

the language.
» Syntax
» Semantic
» Run time

» Load time

Question No: 16 ( Marks: 1) -Please choose one
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A large number of networks interconnected physically is called
» LAN
» MAN
» Internet

» Network collection

Question No: 17 (Marks: 1) -Please choose one

When the packets reach at destination, reassembles them into
original message.

» Protocol
» TCP
» IP

> NIC

Question No: 18 (Marks: 1) -Please choose one

A collection of data organized in such a way that the computer can quickly
search for a desired data item is known as :

» Retrieving
» Database
» Information

» DBMS

Question No: 19 (Marks: 1) -Please choose one

If an algorithm is syntactically correct, but semantically incorrect then this
situation is
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» Very good situation
» Very dangerous situation
» Not very bad

» Neutral situation

Question No: 20 (Marks: 1) -Please choose one
In Heuristics “Common Sense Lessons” are drawn from
» History
» Experience
» Biography of Scientists

» General knowledge

Question No: 21 (Marks: 1) -Please choose one
Users look for solution.

» Optimal

» First good enough

» Good

» Best

Question No: 22 (Marks: 1) -Please choose one
The key property of the ‘Array’ object in JavaScript is
» Value

» Length
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» Name

» All of the given choices

Question No: 23 ( Marks: 1)

- Please choose one

In JavaScript, each element of array can store data of type

» A Number
» An Array
» A String variable

» All of the given choices

Question No: 24 (Marks: 1)

- Please choose one

Which is NOT true for JavaScript variable name ?

» Student
» Roll_no_1111
» For

» schedule

Question No: 25 ( Marks: 1)

- Please choose one

In JavaScript, second element of an array has the index:

> 2
>0
> 1

> 3
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Question No: 26 (Marks: 1) -Please choose one
Which protocol is use to transfer a file over the network ?
» UDP
» FTP
» TCP

» OSI

Question No: 27 (Marks: 1) -Please choose one

Users communicate with the computer using a consistent user interface
provided by the OS.

» True

» False

Question No: 28 (Marks: 1) -Please choose one

Data was stored and counted mechanically using ----------- decimal storage
wheels, rotary dial switches.

» 300,400

» 1300,1400

» 30100,14100

» 3000, 1400

http://vustudents.ning.com

207




Question No: 29 (Marks: 1) -Please choose one

From which of the following is NOT a technique through which Security can be
improved :

» Private or virtual-private networks
» Firewalls
» Metal detectors

» Virus detectors

Question No: 30 (Marks: 1) -Please choose one

Data integrity, in Database management system is necessary because it:

» Refers to provide security to the data
» Refers to provide security to the data
» Refers to maintaining the correctness of data

» Refers to maintaining the consistency of the data

Question No: 31 ( Marks: 1)

What are the types of computer network according to the distance between
nodes ?

Question No: 32 ( Marks: 1)
What is an IP address ?
Question No: 33 ( Marks: 2)

What is internet?
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Question No: 34 ( Marks: 2)

Define semantic web with respect to the present web?

Question No: 35 ( Marks: 3)

Explain how many ways businesses monitor their employees?

Question No: 36 ( Marks: 3)

How can you define a consistent web design? Why is it needed?

Question No: 37 ( Marks: 3)

Differentiate between onLoad and onUnload

Question No: 38 ( Marks: 5)

What is the role of usability in the design of a website?

Question No: 39 (Marks: 5)
Write a short note on:
a. Testing

b. Debugging

Question No: 40 ( Marks: 10)

Write responsibilities of the followings
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1. Developer
2. Executive Team

3. Support Team

Question No: 41 ( Marks: 10)

Write down HTML and JavaScript code for the following requirements:

Declare an Array with the identifier SUBJECT having length 5. Assign following

values to the array elements:
MIS, Java, Algorithms, Databases, C++

Show all values in reverse order.
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FINALTERM EXAMINATION
Fall 2009

CS101- Introduction to Computing

Time: 120 min

Marks: 75

Question No: 1 ( Marks: 1) - Please choose one

What is NOT a key factor while designing a website?
» Usability
» User-friendly
» Consistency

» Complexity

Question No: 2  ( Marks: 1) - Please choose one

To improve the time for scannig a web page, text should be

» Centered
» Left Aligned
» Right Aligned

» Staggered
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Question No: 3  ( Marks: 1) - Please choose one

Which of the following number system is used by microprocessor?

» Binary

» Decimal

» Octal

» Hexadecimal

Question No: 4  ( Marks: 1) - Please choose one

Which one is NOT a presentation software?

» MS Access

» CA Harvard Graphics
» Corel Presentation

» Lotus Freelance
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Question No: 5 ( Marks: 1) - Please choose one

A function is also called

» Sub-program
» Procedure
» Sub-routine

» All of the given option

Question No: 6  ( Marks: 1) - Please choose one

Which of the following data types are recognized by JavaScript?

» Strings
» Numbers
» Undefined
» All of the given options
Question No: 7  ( Marks: 1) - Please choose one

The reserved word allows a determined action to be taken if the first
condition is false.

» For
» While
» Else

» Switch
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Question No: 8 ( Marks: 1) - Please choose one

Security can also be improved through

» Encryption
» Typing errors
» Transmission errors
» Hardware malfunctions
Question No: 9  ( Marks: 1) - Please choose one

The organizations are learning that business can be done in a more effective
manner if emphasis is placed upon

» Cooperation
» Shared responsibility
» Networking

» All of the given options

Question No: 10  ( Marks: 1) - Please choose one

After the DoS attack in year 2000, Yahoo servers were recovered in

» 1 hour
» 2 hours
» 3 hours

» 4 hours
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Question No: 11 ( Marks: 1) - Please choose one

When web server is busy it gives the following message to the user :
» Time out
» Waiting
» Server busy

» None of the given options

Question No: 12  ( Marks: 1) - Please choose one

Tribal flood network is a software.

» DoS
» Scanning
» Utility

» None of the given options

Question No: 13  ( Marks: 1) - Please choose one

Spies of one business monitoring the network traffic of their competitors’

» Industrial Intelligence
» Industrial Espionage
» Industrial Spying

» Industrial Surveillance
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Question No: 14  ( Marks: 1) - Please choose one

Planning and tracking of the project is the responsibility of the

» Architect
» Team Lead
» Developer

» Chief Executive Officer

Question No: 15  ( Marks: 1) - Please choose one

The effective way not to only write programs but also it works properly and
further more to minimize the time and the development cost of the program is
called

» Programming Mechanism
» Programming Methodology
» Programming Synchronization

» None of the given options

Question No: 16  ( Marks: 1) - Please choose one
Sequence of steps that is taken to solve a problem is called
» Algorithm
» Operating System
» Application software

» None of the given options
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Question No: 17  ( Marks: 1) - Please choose one

Which one is correct?
» <BODY></BODY>
» <body></body>
» Both <BODY></BODY> and <body></body>

» <BODY/>

Question No: 18  ( Marks: 1) - Please choose one

In which case Cache Memory is used

» To increase RAM speed

» To overcome BUS speed

» To overcome Speed rate between RAM and CPU
» To overcome CPU speed

Question No: 19  ( Marks: 1) - Please choose one

In Heuristics “Common Sense Lessons” are drawn from
» History
» Experience
» Biography of Scientists

» General knowledge
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Question No: 20 ( Marks: 1) - Please choose one

In a System having many parts to be designed, one should always do the
first

» Hard part
» Simple part
» Development part

» Quality part

Question No: 21 ( Marks: 1) - Please choose one

The key property of the ‘Array’ object in JavaScript is
» Value
» Length
» Name

» All of the given choices

Question No: 22  ( Marks: 1) - Please choose one

One can send an email message to a remote computer using protocol
» HTTP
» SMTP

> FTP
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» TELNET

Question No: 23  ( Marks: 1) - Please choose one
occurs when a function calls itself.
» Recursion
» Call by value
» Call by reference
» Parsing
Question No: 24  ( Marks: 1) - Please choose one
Hardware malfunctions is related to
» Data updates
» Data integrity
» Data security
» Data accessibility
Question No: 25 ( Marks: 1) - Please choose one

With the passage of time the field of Computing and Telecommunication is

» Diverging
» Converging
» Becoming different

» Becoming unique
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Question No: 26  ( Marks: 1) - Please choose one

software directly interacts with the hardware.

» Application software
» System software
» Dynamic software
» Distributed software
Question No: 27  ( Marks: 1) - Please choose one

When the microprocessor desires to look at a piece of data, it checks in the
first.

» RAM
» ROM
» hard disk

» cache

Question No: 28  ( Marks: 1) - Please choose one

By today's standards, the Mark-I was slow and requiring 3 to 5 seconds for a
multiplication operation.

» True

» False
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Question No: 29  ( Marks: 1) - Please choose one

In partitioning of program/module, it should be assured that partitioned

chunks should be as as possible.
» Dependent
» Independent
» Complex

» All of the above

Question No: 30  ( Marks: 1) - Please choose one

Ada is a programming language specifically designed for
» Analytical Engine
» Difference Engine
» Harvard Mark 1

» Mechanical engine

Question No: 31  ( Marks: 1)

What is an Array?

Question No: 32 (Marks: 1)

What are the other names of function? Any one.

http://vustudents.ning.com

221




Question No: 33  ( Marks: 2)
What is meant by semantic error ?
Question No: 34  ( Marks: 2)

Which benefits a developer can achieve by following the heuristics for
system architecting?

Question No: 35 ( Marks: 3)

How can you define a consistent web design? Why is it needed?

Question No: 36  ( Marks: 3)

Define Primary key and Queries

Question No: 37  ( Marks: 3)

Briefly describe Holographic Storage.

Question No: 38  ( Marks: 5)

Write HTML and JavaScript code that displays a textbox and button on a web
page. When user enters text in the text box and click the button it displays that
text in the message box.

Question No: 39 (Marks: 5)

What is Robotics? How Robots making our daily and industrial life easy?

Question No: 40  ( Marks: 10)

Write down the output of the following lines of JavaScript code?

a) <script type="text/javascript">
document.write(Math.round(5.92))
</script>

b) <script type="text/javascript">

var name="Muhammad Abdul Bashir"
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document.write(name.length)

</script>

c) <script type="text/javascript">

var str="This is my test string"
document.write(str.charAt(9))

</script>

d) <script type="text/javascript">

var str="VU Learning Management System "
document.write(str.indexOf("system")+"<br />")
</script>

e) <script type="text/javascript">

var str="Virtual University of Pakistan"
document.write(str.substr(23))

</script>

Question No: 41 ( Marks: 10)

Write down HTML and JavaScript code for the following requirements:

Declare an Array with the identifier SUBJECT having length 5. Assign following

values to the array elements:
MIS, Java, Algorithms, Databases, C++
Show all values in reverse order.
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